INSTRUCTIONS

Welcome to your Continental Academy course. As you read through the text book you will see that it is made up of the individual lessons listed in the Course Outline. Each lesson is divided into various sub-topics. As you read through the material you will see certain important sentences and phrases that are highlighted in yellow (printing black & white appears as grey highlight.) Bold, blue print is used to emphasize topics such as names or historical events (it appears Bold when printed in black and white.) Important Information in tables and charts is highlighted for emphasis. At the end of each lesson are practice questions with answers. You will progress through this course one lesson at a time, at your own pace.

First, study the lesson thoroughly. (You can print the entire text book or one lesson at a time to assist you in the study process.) Then, complete the lesson reviews printed at the end of the lesson and carefully check your answers. When you are ready, complete the 10-question lesson assignment at the www.ContinentalAcademy.net web site. (Remember, when you begin a lesson assignment, you may skip a question, but you must complete the 10 question lesson assignment in its entirety.) You will find notes online entitled “Things to Remember”, in the Textbook/Supplement portal which can be printed for your convenience.

All lesson assignments are open-book. Continue working on the lessons at your own pace until you have finished all lesson assignments for this course.

When you have completed and passed all lesson assignments for this course, complete the End of Course Examination on-line. Once you pass this exam, the average of your grades for all your lesson assignments for this course will determine your final course grade.

If you need help understanding any part of the lesson, practice questions, or this procedure:

- Click on the “Send a Message to the Guidance Department” link at the top of the right side of the home page
- Type your question in the field provided
- Then, click on the “Send” button
- You will receive a response within ONE BUSINESS DAY
About the Author…

Mrs. Brenda Remus earned her Bachelor of Science Degree in Liberal Arts from Excelsior College in New York and her Masters in Information Technology from American InterContinental University in Weston, Florida. She served in the United States Air Force from 1972 until 1992 as a Cryptologic Linguist. From 1992 until 2000, she worked as a government contractor providing technical training. Since 2001 Mrs. Remus has been associated with several universities as adjunct faculty, both on campus and on-line, facilitating information technology courses and also as an academic advisor. Brenda currently resides in Sunrise, Florida with her husband.
# TABLE OF CONTENTS

<table>
<thead>
<tr>
<th>Lesson</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COMPUTER BASICS</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>- Setting Up The Computer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Computer Basics</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>COMPUTER HARDWARE AND SOFTWARE</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>- Hardware – Input and Output Devices</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Hardware – Storage Devices/Inside The System Unit</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Software</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>OFFICE APPLICATIONS</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>- Word Processing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Spreadsheets</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Databases</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Presentations</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>THE INTERNET</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>- Connecting to the Internet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The Internet</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- The World-Wide Web</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>TASK ANALYSIS AND PROBLEM SOLVING</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>- The System Development Life Cycle</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>COMPUTER ETHICS AND CRIMES</td>
<td>71</td>
</tr>
<tr>
<td></td>
<td>- Computer Ethics</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Computer Crimes</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>COMPUTERS IN THE WORKPLACE</td>
<td>79</td>
</tr>
<tr>
<td></td>
<td>- Computers in the Workplace</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- Computer Professions</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>COURSE OBJECTIVES</strong></td>
<td>86</td>
</tr>
</tbody>
</table>

**Figures**

- Figure 1-1, Information Processing Cycle
- Figure 2-1, Ergonomic Keyboard
- Figure 2-2, Mouse
- Figure 2-3, Trackball
- Figure 2-4, Pointing Stick
- Figure 2-5, Touch-Pad
- Figure 2-5A, Joystick
- Figure 2-6, Monitor
- Figure 2-7, Magnified Pixels
- Figure 2-8, Inkjet Printer
- Figure 2-9, Laser Printer
INTRODUCTION TO COMPUTERS

Figure 2-10, Multifunctional Printer
Figure 2-11, Plotter
Figure 2-12, Speakers
Figure 2-13, Hard Drive
Figure 2-14, Hard Drive Structure
Figure 2-15, Floppy Disks
Figure 2-16, Compact Disks
Figure 2-17, Chip
Figure 2-18, DOS Command Window
Figure 2-19, Windows XP Desktop with Opened Application
Figure 2-20, Window Components
Figure 2-21, Menu Components
Figure 2-22, Dialog Box
Figure 3-1, View Buttons
Figure 3-2, Normal Layout View
Figure 3-3, Web Layout View
Figure 3-4, Print Layout View
Figure 3-5, Outline View
Figure 3-6, Workbook
Figure 3-7, Sample Formula Calculation
Figure 3-8, Mortgage Payment Calculation
Figure 3-9, Conversion to Chart
Figure 3-10, Database Table
Figure 3-11, Relational Database Tables
Figure 3-12, PowerPoint Window
Figure 4-1, Internet Access Methods
Figure 6-1, Status Bar with Lock Symbol
Figure 6-2, Secure Site Indicators

Tables
Table 1-1, Ports
Table 2-1, Window Components
Table 2-2, Menu Components
Table 3-1, Document Enhancement
Table 3-2, Excel Production Elements
Table 3-3, Database Terminology
Table 3-4, PowerPoint Window Description

6
LESSON 1 – COMPUTER BASICS

Computers affect almost every part of daily life, sometimes invisibly. The telephone company, power company, and department stores use them to maintain accounts and send out the bills. Surgeons use them to perform delicate operations and children use them to improve reading skills. People of all ages use them at home to write letters create budgets, look up phone numbers, and research data.

Computers come in all shapes and sizes, from ones that fit in the palm of the hand to supercomputers that take up entire rooms. The supercomputer can perform billions of calculations in a fraction of a second. Scientists use them to study weather patterns and earthquakes and for nuclear research. Supercomputers made it possible to map the human genome, a milestone achievement.

This Lesson discusses basic information about computers, from setting up a new computer to detailed information about its component parts.

Setting up the Computer

Where does a user start when setting up a new computer?

When setting up a computer for the first time, it is important to understand what the parts are and how they connect to each other. This lesson discusses how to set up a home computer system.

The first step is to decide where to place the computer and clear that area so there is plenty of room to set it up. The selected place should be near an electrical outlet and a telephone jack if necessary for an Internet connection. At least two pieces of equipment, and possibly three or four if the equipment includes a printer and speakers, need power. It is best to purchase a surge protector, which accommodates several pieces of equipment and provides some protection for the computer system in the event of a power surge.

After organizing the area, the next step is to unpack the boxes. Make sure to leave ample room behind the computer equipment to make it easier to connect the various components. Check the manuals or pamphlets that come with the equipment. They provide setup and operating instructions.

After unpacking the monitor, computer case, keyboard, mouse, and printer, connect all the parts. All the different cables may at first look a little confusing, as they all have different connectors. This helps to identify where to plug in each cable.

Plug each cable into the appropriate system unit socket, or port. Normally ports are in the back, although some newer computer models have ports on the front. The port connects the device (monitor, keyboard, mouse, or printer) to a card that resides inside the system unit, enabling the devices to communicate with the central processing unit. It is important to plug the right cable into the right port. Do not force the plug into a port. If it is difficult to insert the plug into one of the ports, make sure it is the correct port and then look at the pins (at the ends of the cable) to see if any of them are bent. If a newly purchased cable has a bent pin, return the cable to the store and get a replacement. If necessary, straighten the pin, but do so carefully; the pins are fragile and without them, the devices cannot communicate with each other.
Table 1.1 below explains the different types of ports.

<table>
<thead>
<tr>
<th>Port</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial</td>
<td>Connects the mouse, keyboard, printer, or monitor to the system unit and transfers one bit of data at a time, with a transfer rate of 115 Kbps (115,000 bits per second).</td>
</tr>
<tr>
<td>Parallel</td>
<td>Usually connects the printer to the system unit and transfers 8 bits (1 byte) of data at a time, with a transfer rate of 150 KBps (150,000 bits per second).</td>
</tr>
<tr>
<td>PS/2</td>
<td>Connects the mouse or keyboard to the system unit on IBM and some IBM-compatible computers. Normally, a PS/2 port serves a mouse so the common name for it is the mouse port. PS/2 uses serial technology, transferring 1 bit at a time with a transfer rate up to 15 Mbps (15,000,000 bits per second).</td>
</tr>
<tr>
<td>Universal Serial Bus (USB)</td>
<td>Connects the keyboard, mouse, or printer to the system unit and transfers data extremely fast, up to 450 Mbps (450,000,000 bits per second). A USB port is hot swappable, which means it is possible to plug in and unplug the device even while the computer is running. One USB port can serve up to 127 devices, providing far greater capability. More computers now have USB ports. Some computers have USB ports on the front of the system unit.</td>
</tr>
<tr>
<td>Stereo</td>
<td>Connects the microphone and speakers to the system unit. Make sure to connect to the correct one. Usually, the system unit has a small picture of the microphone or speakers above the correct port.</td>
</tr>
<tr>
<td>RJ – 11 (telephone line)</td>
<td>Connects the telephone line to the system unit via a modem card and enables users to connect to the Internet.</td>
</tr>
<tr>
<td>RJ-45 (Ethernet)</td>
<td>Connects an Ethernet network cable to the system unit via a network card and enables users to connect to a local network.</td>
</tr>
</tbody>
</table>
Several computer manufacturers color code the various ports and cables to make connecting the equipment easy. (For example, plug the green cable into the green port.) Make sure to plug all the cables in securely.

Next, connect the monitor, system unit, and printer to the power supply. After plugging in the devices, turn on the monitor and printer, and then turn on the system unit. The power switch for the system unit should be on the front.

As soon as the power is on, the computer performs a Power on Self Test (POST), which tests all of the devices to ensure they are working properly. After completing the POST, the computer loads the operating system in memory. When the logon dialog box appears click on the Cancel button and the system displays the desktop.

When finished using the computer, close all applications and shut the computer down.

**Computer Basics**

What is the purpose of the computer? What does it do? The computer has made our lives much easier and has saved us much time in completing repetitive and boring tasks. The word processing function alone has eliminated countless hours of retyping or rewriting papers to make them look professional.

What is a computer?

A computer is an electronic device that, when given the proper commands, performs a multitude of functions at remarkable speeds. The computer receives the commands from a program, which is a list of tasks that the computer must perform in a given order. The four basic operations the computer performs are **input**, **processing**, **output** and **storage**. These four operations constitute the **Information Processing Cycle**.
Input, which will be discussed in the next session, is the process of entering data into the computer from a keyboard, a mouse, a joystick, a trackball, a microphone, a scanner, a storage device (memory card), or the Internet (sometimes wirelessly). After a user enters the data, the software translates the data into a form that the computer can understand.

Processing, which will be discussed in the next session, is the computer’s use of the data either through arithmetic or comparison operations. The program in use determines how the system processes the data. The process can be as simple as adding two numbers together, comparing the result to a third number and performing another step based on the outcome of the comparison. Computers accomplish their processes at extremely fast speeds, performing millions of calculations in a second. It is important to understand the reliability of computer computations; computers do not make any errors when performing calculations. Errors occur because of incorrect programming or data entry.

- Turn the computer on; it starts up if it is plugged into an electrical outlet and the electricity there is on.
- Open the application by clicking the mouse to select the word processing icon (symbol) on the desktop. This is the first input. The central processing unit (CPU) receives the signal, processes the data, and provides the output by opening the word processing application.
- Begin typing on the computer’s keyboard and the immediate output is the appearance of the document on the screen.
- Finish typing and run the spelling and grammar checks. The CPU compares the entered words with a dictionary that resides within the application. If a word does not appear in the dictionary, the application flags it as misspelled. The grammar checker flags grammar and syntax errors based on the application’s grammar setup. The application displays the results of these checks for evaluation and action. Possible actions include accepting one of the application’s offered alternatives, accepting the flagged item as is, or adding the word to the dictionary so it does not show up as a spelling error in the future.
- After finishing the spelling and grammar corrections save the document to a file. This completes the information processing cycle.
- A computer consists of hardware and software, both of which have to exist for the computer to work. The hardware is the system unit, which consists of the motherboard, the central processing unit (CPU), memory chips, hard drive, floppy drive, and CD drive. Hardware also includes the monitor, keyboard, mouse, printer, and other devices a user connects to the computer. The software falls into two categories, system software, and application software. System software makes all the devices of the computer work together. This type of software consists of the Operating System and Utility software. Application software produces a product, such as a database, document, e-mail, graphic, spreadsheet, or web page.
LESSON 1 STUDY QUESTIONS.

ANSWER TRUE OR FALSE. CHECK YOUR ANSWERS.

1. The supercomputer can perform billions of calculations in a fraction of a second.
2. The four basic operations the computer performs are input, processing, output and storage.
3. The four basic operations the computer performs is called the Information Processing Cycle.
4. Computer software falls into two categories, system software, and application software.
5. Application software consists of the Operating System and Utility software.
6. Errors occur because of incorrect programming or data entry.
7. The RJ—11 port is used for the stereo connection.
8. USB stands for the Universal Standard Broadcast port.
9. The RJ—45 port is used to connect the telephone to the computer.
10. A surge protector is used to protect against system viruses.

ANSWERS TO LESSON 1 STUDY QUESTIONS.

1. TRUE   6. TRUE
2. TRUE   7. FALSE
3. TRUE   8. FALSE
4. TRUE   9. FALSE
5. FALSE  10. FALSE
LESSON 2

COMPUTER HARDWARE AND SOFTWARE

At the end of this Lesson, the student will be able to identify the different components of a computer system to include the parts inside the computer case and the input, output, and storage devices. Additionally, the student will know the function of each component. The student will be able to distinguish between system and application software to include the importance of both and the functions they perform.

Hardware – Input and Output Devices

A computer system consists of hardware and software. The hardware consists of the physical pieces of the computer. The hardware category breaks down further by function: input devices, processing components, output devices, and storage devices.

Input Devices enable users to input data. The two most common input devices are the keyboard and the mouse, although there are many more input devices.

Keyboards are the fastest way to enter data into the computer. When a user presses a key on the keyboard the device sends an electrical impulse over the keyboard cable (or a signal if it is a wireless keyboard) to the Central Processing Unit (CPU), which interprets the impulse or signal and displays the entered character (letter, number, symbol, punctuation mark, or space) on the monitor. The character appears on the screen at the insertion point. The insertion point is normally a blinking vertical line and the typed text appears to the left of this indicator.

Using a keyboard is very similar to using a typewriter. The big difference is that on a typewriter the user must press the return key at the end of each line of text to go to a new line. On a computer keyboard, one presses the Enter/Return key only to create a new paragraph. Computer applications have a feature called Word Wrap that automatically advances to the next line. Another difference between a computer keyboard and a typewriter is that a keyboard has additional keys to enable users to perform different functions.

- **Function keys** (normally F1 through F12) along the top of the keyboard tell the computer to perform specific functions. For example, press the F1 key to access the help feature. The various functions vary according to operating system and applications. It is best to try them out or read the documentation.

- The Ctrl and Alt keys operate with other keys to perform short-cut operations. For example, hold down the Ctrl key and press the B key to make the text from that point forward **bold**. Hold down the Ctrl key and press the B key again to deactivate the bold feature. Most documentation refers to this type of key use as Ctrl + B. Again, the exact function associated with the Ctrl and Alt keys varies from application to application. Review each application’s help feature to see what shortcut keys to use.
• Keys that enable users to move around quickly within an application include the arrow keys, page up and down keys, and the Home and End keys. These keys are usually on the right-hand side of the keyboard. Pressing the Home key moves the insertion point to the beginning of the current line. The End key moves the insertion point to the space after the last typed last character in that line. Pressing Ctrl + Home moves the insertion point to the first character on the first page. Pressing Ctrl + End moves the insertion point to the last character on the last page of the document. Some keyboards may also have other special keys, depending on the manufacturer.

Many types of keyboards are available, from the traditional keyboards to newer ergonomic keyboards. Although at first they may be a little awkward to use, after a while most people find them to be easier. The picture shows an ergonomic keyboard. They are supposed to prevent carpal tunnel syndrome, which is a medical condition some individuals develop from repetitive motion such as keyboard use.

![Figure 2-1. Ergonomic Keyboard](image)

Although the keyboard is the primary data-entry device, a pointing device is another commonly used input device. Any function a pointing device performs a keyboard can also perform, but a pointing device makes it easier to use the computer. Instead of having to remember a variety of different key combinations, such as Ctrl + C (Copy), use the pointing device to select the Copy menu option. Several pointing devices exist, including the mouse, trackball, joystick, pointing stick, and touchpad, with the mouse being the most common.

The mouse is a small device that fits in the palm of the hand. On the top of the mouse there are buttons, either one (for Apple computers), two (most common), or three (for use with UNIX based workstations). The mouse moves over a clean flat surface and enables the user to interact with the computer by clicking, double clicking, or dragging.
Using the mouse, users can access menu options, move the insertion point within an application, move around the screen, select text and objects, and activate a variety of commands. The mouse also can work in conjunction with either the Shift or Control key on the keyboard.

There are a few different ways in which a mouse can connect to the computer. The PS/2 mouse is the most popular and connects to the computer via the PS/2 connector. Other available types include cordless; USB, which connect to USB ports; and serial, which connect to serial ports.

The mouse can be either mechanical or optical. The mechanical mouse has a ball in the bottom and as you move the mouse, the movement of the ball sends digital signals to the computer. The optical mouse usually rests on a mouse pad and uses a laser to tell the computer where the pointer is located. On either type, a click of a button also sends a digital signal to the computer.

A **trackball** is, basically, a mouse turned upside down. The ball moves while the device itself is stationary. The trackball also has buttons to click. It can be difficult to become comfortable with the trackball, but most people who stay with it really prefer it to the mouse.
A pointing stick is a small device that resides on the keyboard; to manipulate it use one finger to move the device in different directions. There are additional buttons on the keyboard to press for the click actions. Pointing sticks are most often on laptops, but some desktop keyboards have them.

**Figure 2-4. Pointing Stick**

A **touch-pad** is a flat surface on which a user places a finger. Moving the finger around the pad moves the pointer on the screen. The touch-pad also has buttons to perform the click and drag options; tapping on the pad mimics clicking a mouse button. Laptop computers and some desktop computer keyboards have touch-pads.

**Figure 2-5. Touch-Pad**

A **joystick** is a pointing device that has a lever the user holds and moves in different directions to move the pointer around the screen. Joysticks also have buttons to mimic mouse clicks. People use joysticks most often to play computer games.

**Figure 2-5A. Joystick**

A touch screen enables a user to press or drag a finger or a light pen on the monitor to mimic mouse actions. Many ATMs, restaurants, and shopping mall kiosks have touch screens.

Another way to input data is through speech or voice recognition. You speak to the computer and tell it what to do. This technology is advancing. When developers perfect this feature, users will not need a keyboard or pointing device. This holds particular promise for disabled users. A user will be able to tell the computer to open an application and tell it what action to take, such as typing a letter. The user can then dictate the letter and when finished, tell the computer to save and print the letter. The limitations of speech recognition include the differences in individual speech patterns and the differences between spoken and written language.

Additional ways to enter data into computers include digital, video, or web cameras and scanners. Computer technology is an ever-growing field, and developers are always discovering and perfecting new ways to input data.

Output devices enable users to see the results of the entered and processed data. The monitor and printer are the two most common output devices; they display text and image output. Speakers provide audio output.

The monitor requires a graphical adapter in order to work. The graphical adapter is a board attached to the motherboard in an expansion slot. The monitor then connects to the graphic adapter via a cable. The purpose of the graphic adapter is to change the digital signal from the processor to a
signal compatible with the monitor. Discussions of monitors generally concern the size, the resolution, and the refresh rate.

One measures a monitor diagonally, the same as a television screen. Most monitors today are in the 15- to 17-inch range, although they can be as small as 5 inches and large as 30 inches. The size of the monitor screen has been increasing over the last several years and the cost of monitors continues to drop.

![Figure 2-6. Monitor](image)

A monitor’s resolution depends on the number of pixels that it displays at a time. Each box in Figure 2-7 below represents a pixel (these are magnified). A monitor’s resolution is the number of horizontal pixels times the number of vertical pixels. Common monitor resolutions include 800 x 600 (800 horizontal and 600 vertical) for 48,000 pixels and 1024 x 768 for 786,432 pixels. The more pixels a monitor displays, the sharper and the smaller the images.

![Figure 2-7. Magnified Pixels](image)

The **printer** is another output device. The many available printers vary in price from less than one hundred dollars to thousands of dollars. The two most common types of printers on the market today are the ink jet and the laser. Additional types are dot matrix, thermal, plotter, and multifunctional.
Small businesses and home users generally use ink-jet printers. These printers are inexpensive, although replacing ink cartridges becomes expensive. An ink jet printer works by spraying spurts of ink onto the paper. Color ink jet printers usually come with two cartridges, one for the black ink and one for the colored ink. The colored ink cartridge contains three different colors and sprays combinations of these colors onto the paper to create the designated colors. The cartridges move from left to right and print one line at a time. When installing a cartridge, DO NOT touch the bottom of the cartridge, because that can damage it. Sometimes it can be difficult to insert the cartridges, so be careful and patient, and read the installation instructions. Ink jet printers usually print 600-1200 dots per inch (DPI) and 4-6 pages per minute (ppm) in color and 10-12 ppm in black.

Businesses are the primary users of laser printers, but because these printers have dropped in price, more people are purchasing them for home use. Laser printer technology is similar to that of copy machines. A laser printer contains a drum. When a user prints a document the printer sends an electrostatic charge to the drum, then laser beams fuse the toner onto the paper as it rolls over the drum. Some people call them page printers because they print an entire page at once. Resolution on the laser printer is superb, starting at 1200 dpi. Laser printers can normally print 10-12 ppm in black and white and 4-8 ppm in color. More color laser printers are becoming available as the cost continues to drop. Laser printers are very quiet compared to other types of printers.

Multifunctional printers, which function as printers, copiers, scanners, and fax machines, are becoming more common for home use. These printers range in price from $100 - $500. Combining four components in one piece of equipment saves space. A multifunctional printer is not much larger than a laser printer.
Plotters enable users to produce blueprints, architectural drawings, posters, banners, and so forth that are too large to fit on letter- or legal-size paper. Plotters use ink jet technology and can print pages up to 48 inches wide and several feet long.

Thermal printers create high-quality prints. A thermal printer has a multicolored ribbon that looks like a colored filmstrip. The device heats the ribbon and transfers the print or image to the paper, tag, or label. Many organizations use thermal printers to produce picture identification cards. A thermal printer ribbon is good for only one use.

Dot matrix printers, or impact printers, contain pins that strike a ribbon to place dots on the paper to form words and images. This type of printer is very slow and noisy. The advantage of a dot matrix printer, and the reason they are still available today, is that they can print multi-ply forms (2-ply, 6-ply, and so forth) and can print banners that are more than one page long. Inside a dot matrix printer on each side is a wheel with spokes. The spokes fit the perforations along the sides of the paper to feed and hold the paper. These printers use continuous-feed paper, and users must separate printed products along the perforations between pages.

Another output device is a set of speakers. Speakers provide audio output. Every computer has an internal speaker through which users hear the programmed sound cues that accompany start-up and other operations. A user who decides to add external speakers must add a sound card if the computer does not have one. The sound card connects to an expansion slot on the motherboard and the ports that the speaker and microphone connect to are on the outside of the system box. The price range and capabilities of speakers vary greatly in today’s market, from inexpensive speakers for under ten dollars to hundreds of dollars for a surround sound system.
Hardware. Storage Devices/Inside the System Unit

Storage Devices

Data storage is an important component of the computer. Storage, also called permanent storage or secondary storage, is non-volatile, and does not lose any of its data when a user turns a computer off. It differs from random access memory (RAM) in that the computer stores the data in RAM only temporarily while a user is working in a particular application and using some data. After saving the data and closing the application, the computer removes the data from RAM and places it into permanent storage. It is much like taking a paper file out of a filing cabinet, working on the papers in the file, and returning the altered file to the file cabinet for future use.

Permanent storage devices include hard drives, floppy disks, CDs, DVDs, tapes, and read-only memory (ROM) chips. These storage devices can perform sequentially or by random access, can have read and write capability or read-only, and can be either magnetic or optical.

In a random access device, the read-write head can access the correct data on the disk quickly. At the beginning of the disk is a table that stores the exact location of every stored file and available (empty) space so it can advance quickly to the correct location and either retrieves (read) or stores (write) the data. Random access devices are the hard drives, floppy disks, CDs, and DVDs.

In sequential storage devices, the read/write head must pass through all data on the device sequentially until it reaches the correct location. The technology is slower but less expensive. Tape devices are sequential.

Another distinction is whether one can read and write to the media or just read the media. Most storage devices provide read and write capability. This means that users can read existing data and store new or changed data. The CD-ROM drive enables a user only to read the information on an inserted CD. Some computers also have a DVD-ROM drive. Hard drives, floppy drives, tape drives, CD-R drives (writes to a CD one time), CD-RW drives (writes to a CD several times), and DVD-RAM drives have read and write capability.

Storage devices use either magnetic or optical technology. Magnetic technology uses disks or tapes with magnetic coatings. As the read/write head moves along the disk or tape it uses electrical impulses to record the data. This activity rearranges the magnetic material on the disk or tape to make the data retrievable later. When a user needs to retrieve data from the disk or tape, the read/write head reads the stored data, creates an electrical impulse, and sends it to the processor. The processor interprets the electrical signal and displays it on the monitor or printer in a user-readable form.
Optical storage devices use a laser beam read/write head to record to or read pits on the CD or DVD disk. The recorded CD or DVD surface contains pits and flat surfaces. The computer reads the pits (zeroes) and flat surfaces (ones). When the read/write head is reading a CD, a pit scatters the light to send a zero and a flat surface reflects the light to send a one. The computer converts the ones and zeroes to a user-readable form.

The **hard drive is the primary permanent storage device** for the computer, containing the operating system, application software, and the majority of the data. The hard drive is a read/writeable, random access, magnetic device. **Hard drives can be internal, external, or removable.** All hard drives also are fixed drives because a metal compartment encases them. They are internal if they reside inside the system box and external if they reside outside the system box. With a removable drive, the user can remove it from the system box and lock it up for storage when the computer is not in use. Some users have more than one operating system and need to switch hard drives when going from one operating system to another.

A **hard drive consists of two or more platters** that rotate at high speeds. Each platter has its own read/write heads on both the top and the bottom of the platter and can store data on both sides. Except for RAM, the hard drive has the fastest access time (how quickly the read/write head can locate the data and begin reading), approximately 9 milliseconds (9 thousandths of a second). The storage capacity of hard drives continues to improve. Hard drives today are normally at least two gigabytes (GB). A GB is approximately a billion bytes. When purchasing a computer or upgrading the hard drive it is important to ensure the hard drive will have enough space. It is best to purchase a hard drive that not only stores the operating system and applications but also has enough space for additional software and data. The rule of thumb is to double the amount of storage necessary for the software the user plans to load on the hard drive. Most operating systems today use 200-300 megabytes (MB). One megabyte is a million bytes. The installed basic applications that a new computer usually has use 700-800 MB. As this is approximately one gigabyte of storage the minimum hard drive capacity should be two GB. It is very common to find hard drives that can hold 20-30 GB of data and this capacity will continue to grow.

![Figure 2-13. Hard Drive](image)

It is necessary to format a hard drive before storing data on it. Formatting a hard drive creates tracks, sectors, and cylinders. When the formatting takes place the read/write head breaks the platter down into tracks and then divides each track into pie-shaped sectors. These tracks and sectors function as an address scheme for the location of files. At the very beginning of the disk is a File Allocation Table (FAT) and it provides the storage locations of files and empty space. This makes it possible to retrieve files quickly and easily and enables the computer to locate empty space for new storage. The cylinder occupies the same track on all of the platters.
Normally a new computer has a formatted hard drive. DO NOT format the hard drive. Formatting erases everything on the drive. For a new hard drive, follow the accompanying instructions to install it.

Partitioning is another way to divide a hard drive. A partition sections off a specific amount of the hard drive space and defines that space as another drive (a virtual drive). Partitions enable a user to install two different operating systems on one computer or to separate the operating system and application software from data files. A floppy disk uses the same technology as a hard drive except that instead of having multiple disks (platters) it has only one. A plastic casing surrounds the circular disk. The casing has a moveable metal slide. When the diskette is in the floppy drive, the read/write head moves the metal slide and is able to read the magnetic diskette. The computer records data on and retrieves data from the disk.

A floppy disk requires formatting before use. Most manufacturers format floppy disks before distribution and sale. The capacity of a floppy disk is 1.44 MB, which is not much data in today’s terms. Other storage devices with much greater capacity are slowly replacing floppy disks.

Magnetic tape is another way to store data from the computer. The primary purpose of using a tape drive and magnetic tape to store data is for backup. Tapes use sequential technology, which is much slower than random access but is still a very good backup solution. The storage capacity of magnetic tape devices ranges from 10 to 100 GB. Many businesses use magnetic tape to back up their data.

Optical storage devices are becoming the most popular way to store data today. They have the capability to store large amounts of data.
**CD-ROM** (compact disc – read only memory) refers to both the disk and the drive. The CD-ROM drive can only read CDs and does not enable a user to write data to a CD. The read-only CD does not accept any data. CD-ROM drives are inexpensive and usually are standard components on computers. Most software available today is on CD-ROM. A CD-ROM can hold approximately **650 MB** of data.

![Figure 2-16. Compact Disks](image)

The **CD-R** and **CD-RW CDs** and CD drives enable a user to write data to a CD. The CD-R drives write to CD-R disks. After adding data to a CD-R a user cannot add or remove any data that is on the CD. This is not a good solution for saving the occasional file, but is effective for backing up important files.

A **CD-RW** drive can write to a CD-RW disk multiple times. CD-RW disks are more expensive than CD-R disks. CD-RW drives can also write to CD-R disks.

**Digital video disks (DVD)-ROM and DVD-RAM** are the newest in optical storage. A DVD can store an entire digitized movie, up to 17 GB of data. They are becoming more popular now that the price is dropping and some of the new computers come with a DVD player as standard equipment. Users can purchase DVD-RAM drives, enabling them to write to DVD-ROM disks.

**Internet storage is becoming quite popular.** To use Internet storage, users rent space from an online storage provider. They pay monthly fees that entitle them to use specified amounts of storage and they can allow several different users to access their data. The advantages of Internet storage include being able to access the data from anywhere with Internet access. Users need not provide space for additional storage devices and pay for only the amount of storage they need. If that need grows, they can obtain additional storage space. Lack of adequate security is one of the main drawbacks of using Internet storage.

**Inside the System Unit**

The system unit is vital because the monitor, keyboard, mouse, and other devices connect to it via ports on the back of the computer. Several components that are responsible for the processing of data reside in the system unit.

This lesson explains what is inside the system unit. When finished students will have a basic understanding of how the various parts function.
When one looks inside a system unit, it is immediately apparent that the unit contains several wires and circuit boards. A closer look reveals a motherboard, the CPU, RAM chips, the ROM chip, expansion cards, a power supply unit, fan, hard drive, and other peripheral devices.

The motherboard is a circuit board that houses the CPU, RAM chips, ROM chip, and expansion cards. The motherboard also contains the data bus, electrical wire that allows the CPU to communicate with the other devices. The number of parallel wires determines the amount of data the system transfers at one time. Each wire holds one bit of data, so 16 wires can transfer two bytes of data (eight bits equal one byte) at one time; a 64-bit bus transfers eight bytes at a time. Different types of data buses exist depending on the device, but they all work the same way.

The power supply unit converts alternating current (AC) to direct current (DC), which the computer requires to run properly. The power supply has several wires with plugs on the ends. The various devices such as the motherboard, hard drive, floppy disk drive, and CD Drive have sockets that connect to the power supply plugs.

The system fan’s purpose is to keep the inside of the system unit cool. With the devices working at high speeds, the inside heats up quickly. If the system fan is not working it may be necessary to turn the computer off to avoid damage.

The Central Processing Unit (CPU), where all the calculations take place, resides inside the system unit. There are several different types of CPUs but all perform the same functions and consist of two main parts, the control unit and the arithmetic logic unit (ALU).

The control unit, as its name implies, manages the activities and resources of the CPU. The control unit fetches data from memory, decodes it, sends it to the ALU for processing, and sends the data for storage if necessary.

The ALU takes care of all of the calculations. When a user performs any action on the computer, for example pressing the letter “B” on the keyboard, the computer converts the action to a number. The ALU is then able to perform arithmetic or logical operations. The arithmetic operations are adding, subtracting, multiplying, dividing, or raising a number by a power. Logical operations are comparisons: equal to, not equal to, less than, greater than, less than or equal to, greater than or equal to. These calculations are the basis of the computer’s ability to perform its functions.

Often the CPU moves data from one place to another. Data travels from the hard drive to RAM, then RAM to the printer or back to the hard drive. The Control Unit performs these actions but when a calculation is necessary, the Control Unit passes the data to the ALU. All of this takes place extremely fast. The CPU can execute millions of instructions in a second.
Memory is a vital part of the computer. The computer stores data that needs processing in memory chips. Some data is in permanent storage on memory chips called ROM. Other types of data are on storage devices and the computer moves needed data to memory. The CPU processes the data. Because it needs to have the data handy, when a user is working on a file or using a particular application the CPU fetches that data from a storage device and moves it to memory. There are two types of memory, permanent (non-volatile) and temporary (volatile). Random Access Memory (RAM) is volatile and ROM is non-volatile; both play important roles in the computer’s operation.

ROM chips always contain the same data. Engineers who build the chips permanently etch the data onto the chip. A primary reason for this is that the computer needs to know what to do when a user turns it on. The computer’s startup sequence is in ROM. A part of the start up process is to fetch the operating system from the hard drive and move it to RAM. Once this task is accomplished, the operating system takes over.

RAM chips temporarily hold data and the data change as necessary. A portion of RAM always holds part of the operating system, the other areas store open applications or files. Picture RAM as post offices boxes, each having a box number (its address). The CPU fetches data from a storage device and sends it to a specific location (address) on the RAM chip, just as someone places mail in a mailbox at the post office. The CPU remembers the data’s storage location; when it needs the data it tells the RAM chip to send the data from a specific address. The CPU then performs whatever actions it needs on the data and sends it back to the RAM chip or the storage device. When a user turns a computer off all RAM erases any data that it contained. If a user works on a file and shuts down the computer without saving the data to a storage device, the computer can lose the file. Computers always ask users if they want to save any unsaved data when closing an application or shutting down the computer. Problems occur when the system loses power or has a system crash and a user has unsaved work. Therefore, it is imperative to save often when working on important files. Most software applications also have an auto-save feature that users can set up to save data automatically every 10-20 minutes.

New computer models may have RAM chips on expansion cards, such as the video or sound card, and inside printers. Also, as there are different types of RAM chips, the user manuals that come with system units describe the type of memory chips each computer has.

Expansion boards are circuit cards that a user can place inside an expansion slot on the motherboard. A port then extends outside the system unit to accommodate the appropriate device. Some expansion boards or cards, such as the video, sound, and network cards, already are part of the system unit. Each card works with a specific device and contains the appropriate circuitry to enable that device to communicate with the CPU and other devices as necessary.

Another important item in the system unit is the system clock. The system clock determines the speed of the computer and maintains the system time. Clock speed refers to the number of times per second the clock cycles. The CPU can carry out one instruction per cycle. Some current computers have clock speeds above one gigahertz (Ghz), which equates to one billion cycles per second. The system clock runs all the time even if the computer is off because the motherboard has a battery that provides power for the system clock. Occasionally, a battery goes bad and the clock starts to lose time. If this happens, think about replacing the battery. It is rare for the battery to quit working before a user replaces a computer.
The computer works because the devices inside the system unit are able to interact with the input, output, and storage devices. This happens because programmers created instruction sets in the form of programs for the computer to follow. **Remember** that without a program the computer is a very expensive collection of metal and circuitry; it cannot function without the instructions.

**Software**

Computer hardware alone does not work. A user can assemble all of the components and peripherals, plug it all in, and turn on the system - but nothing would happen. The computer requires software to function. **Computer software is simply a set of instructions.** These instructions enable the computer’s hardware to function from the time you turn on the computer. **Software falls into two major categories, system software and application software.**

| System software manages the way the computer hardware functions and how each component interacts with the other components. This type of software includes the operating system software and system utilities. |
| Application software enables users to complete tasks. This includes applications such as word processors, spreadsheets, graphics, databases, and games. |

**System software is vital to the proper functioning of the computer.** The two categories of system software are operating systems and system utilities, which include backup, disk recovery, file management, file compression, and anti-virus software.

The operating system (OS) directs the internal signals so they arrive at the proper destinations and ensures that the system performs the proper set of operations on the data. The operating system usually resides on the computer’s hard drive. Turning on the computer sends the most important part of the OS to the computer’s memory so it is readily available to perform its various functions quickly. This part of the OS is the kernel, and because of its importance to the overall operation of the computer, it always resides in the memory when the computer is on. Other parts of the OS remain on the hard drive and the system copies them to memory as necessary.

Several operating systems are available on the market. Because the OS must interact with the hardware and other programs it’s necessary to develop them to work together. Probably the most widely used OS today is Microsoft Windows, which works with the Intel family of processors, whereas the Mac OS will not run on a PC that uses an Intel processor.

The same principle applies to application software, which works with a specific OS. Users who run Windows programs on a Mac computer use emulating software that works like Windows between the application and the OS. The application is interacting with the emulation of Windows, not directly with the Mac OS. Windows-based applications do not run as well on a Mac.

All operating systems perform the same basic functions; they differ in the ways they accomplish the tasks. They all control programs, allocate hardware resources such as the memory and input and output devices, and enable interaction between the computer and the user.
The OS controls the programs by managing the execution of the various programs on the computer. Program management can be either single tasking or multi-tasking. With single tasking only one application can run at a time. To use another application a user must first close down the one currently running. This is not convenient for most users, who often need to run two or three different applications at the same time. Multi-tasking operating systems are the norm today and allow two or more programs to run at the same time. What actually happens is the CPU switches constantly from one program to the next, but it happens so fast that a user does not realize that the programs are not running simultaneously. The program that is in the foreground (the one currently in use) is the active one; the other program is in the background and is inactive.

The three types of multi-tasking are cooperative, preemptive, and multi-threading. Preemptive multi-tasking dictates that the program running in the foreground is in control until all tasks are finished. The problem with preemptive multi-tasking is that if the program running in the foreground crashes, freezes, or hangs up the user loses everything because that program will not relinquish control of the CPU. The only remedy is to reboot (restart) the computer, with the loss of any unsaved work on all programs running. Windows 3.1 and older versions of the Mac OS are examples of preemptive multi-tasking. Cooperative multi-tasking differs in that if the program in the foreground crashes, the program relinquishes control of the CPU. The user loses unsaved work in only that application and can continue work in any other programs that are running. Linux, Windows 95/98/NT, and the newest version of the Mac OS are examples of cooperative multi-tasking. Multi-Threading enables more than one process to run simultaneously. One can print a 100-page document in the background and instead of waiting for the printing process to finish can begin work in another application.

Network environments have Multi-User operating systems. These allow multiple users to access the same data files and applications at the same time and to communicate with each other. Normally this requires one or more servers for the files and various programs, and the users’ computers are clients.

Through the years there have been several different operating systems, some of which are still in use today.

AT&T and Bell Laboratories developed UNIX in 1969. This is one of the first of the modern operating systems and one that leads the way concerning what an operating system is and what it should do. UNIX used to be very popular in major corporations, universities, and the Department of Defense. The developers intended for experts to use UNIX. Consequently, they devoted little time or effort to making it user-friendly, so the command line format intimidates many people. UNIX is very similar to the disk operating system (DOS), which was also a command-line driven OS. Over time there have been many versions of UNIX, such as Sun Solaris, HP UNIX, IBM’s AIX, XENIX, and BSD.

Microsoft developed DOS in the 1980s. The first version in 1981 was the operating system for the IBM personal computer (PC) and ran on the 8086 processor. DOS users had to learn a variety of commands to operate the computer. Microsoft continued to improve DOS through the 1990s. DOS version 6.2, which Microsoft released in 1994 is supposed to be the last version. Today DOS is not the operating system on a computer but any computer that is running a Windows operating system will provide access to a DOS prompt where one can enter DOS commands. To access the DOS prompt,
select **Start** and then **Run**. When the Run dialog box appears, enter `cmd` in the Open text box and press the **Ok** button. The DOS window appears and one can enter DOS commands.

![Figure 2-18. DOS Command Window](image)

Macintosh Apple computers use the **MAC OS**, which was the first graphical user interface (GUI) operating system in common use (the others available were too expensive for the common user), and which debuted in 1984. The operating system was System 1. The Mac OS is now up to System X (System 10).

**Linux** is the PC version of UNIX. **Linus Torvalds** developed it in 1991 while attending college, when he wanted an OS that was more comprehensive and reliable than Windows. Linux is freeware, or free software, and although Torvalds developed it he does not own it. The people who have continued to develop it and those who will continue in the future own it. Users can download the operating system, copy it, and distribute copies without charge because Linux has no copyright restrictions. Anyone who downloads and changes the operating system is supposed to let others know and then redistribute it without charge. One can download the operating system from several sites on the Internet for no charge. Several vendors sell the software for a reasonable price. Users pay for this software because the vendors may have added additional utilities and they bear the cost of creating the CDs, the book, and packaging. Linux, like UNIX, has a variety of versions such as Red Hat, Mandrake, and Fedora. There are many variants; anyone who is interested can search for Linux on the Internet.

Like UNIX, Linux uses a command line interface and the majority of the commands are similar to those in UNIX. There are graphical user interfaces that you can load on top of the Linux software so the environment looks similar to Windows or Mac and makes using Linux much easier.

Microsoft’s Windows operating system started in 1985 with Windows 1.0, which had a GUI interface but because it required that DOS reside on the computer, it was an extension of DOS. For Windows 3.1 users had to load DOS first then Windows 3.1 on top. Windows has become more robust and stable through the years. As Windows is the most popular of the operating systems, this lesson discusses it in detail.
When a user first turns on a computer it performs a series of system checks to make sure everything is running correctly. When the system detects that all the components are working properly, it beeps. If there are problems the computer issues a series of beeps depending on the error(s) and displays an error message on the monitor. Once all is satisfactory, the startup continues and the system prompts the user to log in or the Windows Desktop appears. On most networks users must log in and on home computers most users don’t have to log in unless they have set up accounts for multiple users.

![Figure 2-19. Windows XP Desktop with Opened Application](image)

The Windows desktop contains a variety of icons (symbols) that a user can click on to start applications or open files. There are also shortcut icons on the desktop. The difference is that a shortcut icon has an arrow in the lower left hand corner and leads to an area on the hard drive when a user opens an application or data file.

Normally, the **Start menu** appears across the bottom of the desktop. Clicking on the **Start button** opens a menu from which the user can open an application, utility, or file. One can move this bar to other locations on the desktop. To the right of the **Start button** is the **task bar** and when a user is running an application, the system displays a button to represent that application. Users can maneuver between applications quickly by clicking on the appropriate button. On the far right are the system clock display and other applications that may be running in the background such as Instant Messaging and anti-virus software. When a user opens an application, it appears inside a window, as Figure 2-19.
illustrates. Figure 2-19 also shows the **Office Assistant**, a utility that provides help for MS Office applications.

The desktop is the user’s first interface with the Windows operating system. It is a graphical user interface. All windows consist of a variety of components.

![Figure 2-20. Window Component](image)

**Table 2-1. Window Components**

<table>
<thead>
<tr>
<th>Feature</th>
<th>What it Does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>The title bar contains the application icon, the file name (if any), the application name, and a set of window control buttons on the right side. A user can move the window by placing the mouse pointer on the title bar, holding down the left mouse button, dragging the window to a new location on the screen, and releasing the left mouse button. A user also can left click on the application icon and a pop-up menu appears providing window action options.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>The menu bar contains a list of the available menu options. Not all applications have the same menu. Each application displays a list of the available commands for a selected menu. The menu options vary from application to application but almost all have the File, Edit, View, Insert, Format, Tools, Window, and Help menus. The commands fall into categories that fit the menu types.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>Toolbars enable users to select a variety of commonly used commands by clicking on the appropriate buttons. Several different toolbars can be open simultaneously. Different applications can have different choices available, but most have the Standard and Format toolbars. The Standard</td>
</tr>
</tbody>
</table>
toolbar includes the commands new, open, save, email, print, print preview, spell check, cut, copy, paste, format paint, undo, and redo. The Format toolbar contains commands for changing the format of a file, such as font type, size, bold, italics, underline, alignment, and bullets. To see a list of available toolbars select the View menu then select Toolbars. The Toolbars submenu displays a list of available toolbars. The application is currently displaying every checked toolbar. Toolbars normally appear just below the menu bar but may appear across the bottom of the window or be floating. Select the desired toolbar to activate it. Occasionally, when a user performs certain functions, a toolbar for the function appears.

<table>
<thead>
<tr>
<th>Status Bar</th>
<th>The Status bar resides along the bottom of the window and provides information on the currently active file. The actual information that appears differs depending on the application.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scrollbars and Scroll Arrows</td>
<td>Horizontal and vertical scrollbars within a window enable users to scroll through the window either horizontally or vertically. A scrollbar’s size changes as a user adds and deletes information or resizes the window. The length of the scrollbar indicates how far it is to the end of the file. The shorter the scrollbar the farther there is to scroll. The scrolling arrows enable users to scroll at different speeds. For example, in Microsoft Word, pressing one of the double-arrow scroll buttons with the mouse tells the application to display the preceding or next page. Pressing one of the single-arrow scroll buttons on the vertical scrollbar tells the application to scroll up or down one line at a time.</td>
</tr>
<tr>
<td>Windows Control Buttons</td>
<td>The Windows control buttons are the three buttons on the right side of the title bar. These three buttons represent the following commands: Minimize – Keeps the window active but does not display it on the screen. The Windows task bar contains an icon that corresponds to the application. Click on the icon to tell Windows to display the application on the screen again. This is helpful when working with multiple applications or files at the same time. Maximize/Restore – The middle button enables a user to maximize the window so it is as large as the screen or restore the window to a size that does not take up the entire screen. Users cannot move or resize a maximized window. Exit – Clicking on this button exits the application. If there is unsaved work within the application a prompt appears asking whether or not to save the work before Windows closes the application.</td>
</tr>
</tbody>
</table>
In the lower right corner of the window, on the status bar, three diagonal lines appear. When a user places the cursor over these lines the cursor changes to a two-headed arrow. When this happens, users can hold down the left mouse button and then drag the mouse to change the size of the window both horizontally and vertically. Users also can do this from any of the other corners of the window. To change only the height of the window, place the cursor along the bottom or top edge of the window. To change only the width, place the cursor on the right or left edge of the window. In both cases, the cursor again changes to a two-headed arrow and the user can drag the edge to the appropriate size.

Main Body or Workplace

This is the largest area of the window where users actually perform tasks. Users can type text into a word processing application, add numbers to a spreadsheet, or add graphics to presentation software.

When a user selects a menu, a drop-down menu of command options appears. Each menu contains associated or similar commands. For example, under the File menu option the choices pertain to operations that affect an entire file, such as save, print, close, exit, open, and new. The edit menu has options that enable a user to manipulate the data in an application, such as cut, copy, paste, delete, select all, find, and replace. Open a menu either by clicking on the menu with the left mouse button or by holding down the ALT key on the keyboard and then pressing the key for the underlined letter for the desired menu. For example, to open the View menu hold down the Alt key and press down on the “V” key. When the menu first appears, two chevrons pointing downward may appear. This means there are more menu options. Click on the chevrons to see the remaining options or leave the menu open and the system displays the rest of the options. A selected menu choice executes a command or displays a sub-menu or a dialog box where users make further selections or enter additional information so the system can execute the command.

Figure 2-21. Menu Components
Table 2-2. Menu Components

<table>
<thead>
<tr>
<th>Feature</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option followed by three ellipses</td>
<td>This means additional user input is necessary for the application to perform the command. A dialog box enables users to provide the required additional input. Zoom is an example. When a user selects Zoom, a dialog box appears and the user selects the desired zoom size.</td>
</tr>
<tr>
<td>Arrow to right of option</td>
<td>The application displays a sub-menu from which users can select additional commands. The Toolbars menu selection is an example of this feature; there are several toolbars, so users need to select the toolbars they want.</td>
</tr>
<tr>
<td>Checkmark</td>
<td>Checkmarks appear next to selected menu options. Usually users can make several choices at the same time and each selected option has a checkmark to the left. To deactivate click on the menu option again. It is an on/off toggle.</td>
</tr>
<tr>
<td>Selected item or dot</td>
<td>Sometimes the options are a grouped set with either a dot or a square marking the selected option. In that case, a user can select only one of the choices at any one time. For example under the View menu are the options Normal, Web Layout, Print Layout, or Outline. These are the available choices of ways to display the workplace area. Only one choice is available at a time. The selected view has a square around the icon.</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
<td>If a particular option on the menu has a shortcut key combination available to execute the command, the application displays the shortcut to the right of the option. Shortcut keys enable a user to continue to use the keyboard to execute certain commands. For example, to view the task pane hold down the CTRL and Shift Key then press the O key. Short cuts are combinations of either two or three keys, normally including the Ctrl key. If the Ctrl, Shift, or Alt key is part of the combination, hold down that key while pressing the letter key.</td>
</tr>
</tbody>
</table>

The dialog box is another important element of the Windows operating system. When a user selects a menu option that has three ellipses following the name, a dialog box appears. Users must enter additional information in the dialog box before the system can execute the command. Often the dialog box that appears has several tabs across the top. In that case, select the appropriate tab. Users may select options on more than one tab. Users indicate their choices in a dialog box by either entering text, selecting radio buttons, selecting options from drop-down boxes, selecting options with check marks, or moving slide bars. After indicating all appropriate choices, click on the OK button and the application executes the command.
Device Drivers are small executable programs that enable the operating system to communicate with peripheral devices. Printers, monitors, and other peripheral devices usually come with device driver software.

System Utilities are other executable programs that assist the operating system in maintaining the system’s integrity. Some system utilities come bundled included with the operating system and users purchase others separately.

File Management utilities help users manage their files. In Windows, Windows Explorer is a file management utility. This utility allows users to view all of their files and folders. They also can use this utility to create new folders, copy, paste, and move or delete files or folders. It also displays information on the file, to include the file name, file type, size, and date modified. Additionally, users can access files and folders using My Computer. For a computer that is part of a network a user also can use My Network Places to view files and folders.

File compression is another utility that enables a user to compress a file or group of files. File compression utility programs use an algorithm to remove blank spaces and sometimes shorten words. When the user expands a compressed file the utility uses the algorithm again to put the file back in order. WinZip is a popular file compression utility and anyone can download a trial version from WinZip.com.

Disk Scanner is a utility that enables a user to check a hard drive for physical or logical problems. If it finds a problem it attempts to fix it. A warped or scratched segment of the hard drive is a physical problem. The disk scanner blocks the affected segment of the hard drive from use. A logical problem occurs when the power goes out and a user cannot save all affected files. Running the scan disk utility is time-consuming but effective.

Windows XP comes with its own compression package. The utility also provides archives, enabling users to store two or more files together. Create a folder and place all the needed files in the
folder. Next compress (zip) the archive file, reducing the file size considerably. The archive file is then ready to email.

The File Defragmentation utility enables a user to eliminate wasted space on the hard drive to reduce the time it takes to access a file. Over time, as a user saves, modifies, and deletes files they become fragmented. The system may have saved one file in three different areas of the hard drive. During defragmentation the computer attempts to place all the segments of a particular file back together. Using this utility improves system performance.

Backup Utilities enable users to create backups of their systems. There are two different types of backups, full and incremental. The full backup backs up the entire system or makes a mirror image of the hard drive. A user can save the backup to some type of storage media, such as a tape drive or zip drive. An incremental backup backs up only the files a user has changed or added since the last backup. How frequently a user performs the different types of backups depends on the importance of the information. Incremental backups are usually daily and full backups may be weekly. There is no set standard. If there is a system crash or if a user loses a file, backups make it possible to recover missing or damaged files. It is best to keep backups in a fire-safe box or somewhere separate from the system so that in the event of fire or other disaster the files are available.

Anti-Virus software protects a computer against viruses. A virus is a small program that changes some part of your operating system, often making your computer unusable. Most of the companies that provide anti-virus software have extensive databases that have the signatures of the known viruses. The software examines specified files for known signatures and fixes the problem or deletes the virus. Viruses change and people are always creating new ones. Most companies allow people to download updates. This is an important action for the protection of any computer. Viruses can wreak havoc.

Occasionally, friends or family members may send emails saying they may have inadvertently transmitted a virus to you and recommending specific actions. Do not take any action without checking on the virus on the Internet or with one of the various anti-virus software companies such as Norton or McAfee. A user can perform a search and find out whether it is a hoax or not. This is important because if it is a hoax and users who perform the suggested actions may delete one or more important files on their computers.

A software application is software that performs various specific tasks. Applications fall into two major categories, horizontal and vertical.

Vertical applications are unique to a particular type of work, a specific division, and so forth. Car dealerships, hospitals, and government agencies can all have software unique to their organizations or business enterprises. Because of the reduced market for vertical applications, they generally cost more than horizontal applications. Anyone who cannot find a horizontal or vertical program to satisfy specific needs must obtain custom software.

Horizontal applications are not unique to a particular area but are in general use. These are word processing applications for creating documents, spreadsheet applications for working with numbers and formulas, database applications to store data in a useable form, presentation applications
to create slides, and graphic packages to work with and create graphics such as images and pictures. Horizontal software falls into the categories of personal productivity, multi-media, Internet access, and educational, informational and research applications.

- **Personal productivity** applications are word processing, spreadsheet, database, and presentation packages and address books.
- **Multi-media applications** are desktop publishing and graphic packages.
- **Internet access applications** provide web browsers, file transfer protocols, and email packages.
- **Educational, informational, and research applications** provide references such as Encarta’s Encyclopedia.

Before loading software a user must make sure the computer meets the appropriate system requirements. This includes the appropriate amount of RAM, hard disk space, processor speed, and OS. RAM and hard disk space requirements show the minimum and recommended amounts. The listed required hard disk space refers to free space. If new software needs 450 MB of hard disk space, the computer must have at least 450 MB of free space. If the computer has only 450 MB of free space, it is inadvisable to load the software without first deleting unneeded items. Before buying new software, users should know their system specifications.

To determine how much free hard drive space the computer has, open the My Computer icon on the desktop and place the mouse pointer on the local disk (C:). The computer displays the size of the hard drive and amount of free space. In an older version of Microsoft Windows it may be necessary to click the right mouse button on the local disk (C:) icon and then select Properties from the pop-up menu that appears. Once the dialog box appears, click the left mouse button on the General tab if it is not already showing.

To determine the amount of random access memory the computer has watch the screen during the startup process or select the Start menu and then select Programs, Accessories, and System Information. When the System Information dialog box appears, click the left mouse button on System Summary and then find the memory information in the box on the right hand side.

**Software applications can be commercial, shareware, or freeware.**

The owners of commercial software hold the copyright and license on it, and users must purchase the software before installing and using it.

**Shareware is also under copyright protection** but the developer of the program allows users to try out the software before buying it. Usually users must purchase the software to get full functionality, but can determine during the trial period whether they like the software or not. Users usually have a 30-day trial period and if they don’t purchase the software when the time is up, should remove it from their computers. Sometimes the software will not allow access after the trial period. Other applications display pop-up messages saying the time is up and the user should buy it to continue to use it. Users who continue to use it without purchasing it usually find that their products contain some graphic or text stating they are not using a licensed copy of the software. One can often download shareware from the Internet free or purchase CDs for a minimal fee, usually less than $10.
Freeware is copyrighted material that the owners make available without charge. One may use this software, share it with others, or make copies of it, but may not sell it to someone else.

Another type of software is beta version software. One can download this software without charge and without guarantee that it will work properly. The vendor is still developing and testing the product and allows users to download and try out the software. This helps the vendor identify software deficiencies (bugs) and serves as a market test of the software. Like shareware, beta version software usually expires after a certain amount of time.

The software license is the documentation that states how one may use purchased software. Software licenses can be single licenses or site licenses. The software users purchase to use on home computers is usually of the single license variety. That means one may install that software on only one computer. Users with more than one computer at home should not install the software on another computer without removing it from the first computer. Businesses buy software with site licenses so they can install it on more than one computer. The more site licenses a purchaser buys, the less each individual license costs.

The set of numbers following a software product’s name, such as DOS 6.2, designates the software version. Most vendors are continuously upgrading their software. When they upgrade the software extensively, they issue it with a new version number. When they make minor changes and fix bugs, they issue maintenance releases. The number of a maintenance release follows the version number and a period. Therefore, DOS 6.2 is the sixth version of DOS and the second maintenance release.

LESSON 2 STUDY QUESTIONS

ANSWER TRUE OR FALSE QUESTIONS 1-5. CHECK YOUR ANSWERS.

1. RAM is a type of memory chip that always retains data even when the computer is off.
2. Most vendors are continuously upgrading their software.
3. Freeware is copyrighted material that the owners make available without charge.
4. Horizontal software falls into the categories of personal productivity, multi-media, Internet access, and educational, informational and research applications.
5. Anti-Virus software protects a computer against viruses.
Identify the various input and output devices.

6. Keyboard ______
7. Monitor ______
8. Mouse ______
9. Printer ______
10. Trackball ______

ANSWERS TO LESSON 2 STUDY QUESTIONS.

1. FALSE  6. f
2. TRUE  7. e
3. TRUE  8. a
4. TRUE  9. b
5. TRUE  10. d
LESSON 3

OFFICE APPLICATIONS

This lesson addresses the fundamentals of each of the major application categories. Students will learn the basics of each category: word processors, spreadsheets, presentation graphics, and databases.

Word Processing

Word processing software enables users to create professional looking documents. Users can create outlines, letters, memoranda, essays, research papers, and reports, to name a few. After a user masters the basics, using a word processor is easy and much faster than using a typewriter. The main purpose for using a word processor is to write, edit, format, and print documents such as essays, letters, memoranda, resumes, and reports. Word processing software empowers users to add information from many media, read and evaluate it, and use it to develop documents.

When opening a new word processing document, a user can begin with a blank document with no predefined formatting or open one of the many templates or wizards available in most word processing applications.

A template determines the structure of the document and has some predefined settings, such as font size and type, style, margins, and page layout. The application formats blank documents according to its normal template. In Microsoft Word, one can find and use additional templates by selecting the General Templates link on the New Document task pane. If one is not quite sure how to write a memo or create a resume, this is a good place to start.

A wizard is a step-by-step procedure that assists users in creating a document such as a resume. The wizard asks the user to enter specific information in several steps. After entering data for each step, the user selects the “Next” button until he or she has entered all of the requested data. When the user clicks on the “Finish” button, the document appears mostly or entirely complete. Wizards are under the Template link.

Besides the templates and wizards that come with Microsoft Word, one can find many templates and wizards on the Internet either by going to the Microsoft web site (www.microsoftoffice.com) or by using a search engine to find others. Users also can design their own templates and save each as a template file for future use.

Using a word processor to write a document is much simpler than using a typewriter. With a word processor, after writing a document one can edit, format (organize) and print it. With a typewriter, one must write, edit, and format all at once. If one makes too many errors or the formatting is not correct, one must start over. With a word processor, writing, editing, formatting, and correcting take place throughout the process of creating the document. That is the advantage of using a word processor.
Another difference between word processors and typewriters is that a typewriter requires a user to press the carriage return key at the end of every line, while word processors have a feature called word wrap that automatically moves to the next line when the typed characters reach the right margin. The **Enter/Return** key is necessary only to start a new paragraph. A word processor recognizes a paragraph as a block of text that begins when a user presses the enter key and ends at the next use of the enter key.

Word processors offer different ways to view documents on the monitor. The views are normal view, web layout view, print layout view, and outline view. Change the view by selecting one from the View menu or one of the buttons to the left of the horizontal scroll bar. From left to right they are normal, web layout, print, and outline views, with a square surrounding the current view. Click on the desired view.

In the Normal Layout view, the document looks like one long sheet of paper. Dashed lines across the paper denote page breaks. In the normal view, one cannot see how the printed page will look.
The Web Layout view displays a document as it would appear on a web page (on the Internet).

The Print Layout view displays a document as it will look in print.
The Outline view displays a document in an outline format. This view is useful if a document has headings, sub-headings, and bullet points. It does not show all the text.

Another feature of the word processor is its ability to create new pages. It automatically knows when to create a new page and does. When a user makes changes such as adding text or footers to the document, the application automatically repaginates. A user can create a new page deliberately by selecting Insert → Break → Next Page. This method ensures that later additions or changes will not affect following pages. It is not necessary or advisable to press the Enter key repeatedly until a new page appears. With that method, later additions to a page cause text on the following pages to move. It is always best to use the insert new page feature to create a new page when the current page is not full.

A user also can add headers and footers, page numbers, pictures, field codes and objects to a document. Each of the items enhances the document.

**Table 3-1. Document Enhancement**

<table>
<thead>
<tr>
<th>Item</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Header and Footer</td>
<td>Add headers and footers to a document by selecting View → Headers and Footers or Insert → AutoText → Headers/Footers and then selecting the desired information. The header area is at the top of the page, the footer at the bottom. Header or footer information appears on every page of the document unless the user specifies otherwise. When the header and footer feature is on, the top and bottom of the page have dotted rectangles showing header and footer locations on the page. Additionally, the Header/Footer toolbar appears. A header or footer normally contains the name of a document, page number, chapter number or title, or other identifying information, but the contents are entirely up to users. The Header/Footer toolbar enables users to toggle between the header and footer areas and insert page number, total number of pages, and the date and time. Users can use page setup to format headers, footers, and pages. After entering the information, click on the...</td>
</tr>
</tbody>
</table>
### Item Descriptions

#### Close button on the toolbar or click inside the main body of the document.

Headers and footers are only viewable in the Print layout view and appear grayed out. In other views, even though they do not show on the screen they do appear in the printed document.

#### Picture

It is possible to add pictures and or clip art to a document by selecting Insert → Picture, then the desired type of picture (for example, Clip Art, From File, Word Art, or Organizational Chart). After a user selects a type, the appropriate dialog box appears and the user selects additional options. After adding pictures or clip art, users can manipulate the text and picture alignment. Right click on the picture and select Format Picture from the pop-up menu that appears.

#### Object

Users can insert objects such as an Excel Spreadsheet or a PowerPoint slide. To make changes to object after inserting it, double click on the object and it opens in its original program. A user can insert a variety of objects depending on the software on the computer. Select Insert → Object and when the dialog box appears select the appropriate object.

#### Field Code

Field codes are special items that a user can insert into a document, such as the date and time. If a document contains the date as a field code and the user has set it up to change according to the date, each time the user opens the file the current date appears. Select Insert → Field and select the desired type of field from the list.

#### Table

Inserting tables into a document helps a user organize data in a format that is easy to read. Tables can also serve to create a page layout as with desktop publishing software. Select Table → Insert → Table and then choose the table size by selecting the number of columns and rows.

#### Hyperlink

Hyperlinks enable users to navigate quickly through or between documents, or between a document and a web page on the Internet (if on line at the time). After creating bookmarks for the desired connections, select Insert → Hyperlink and select the type of hyperlink, the name of the hyperlink, and the target (where the link goes). Hyperlinks only work in electronic files and to link to a web site the reader needs an active Internet connection. If the hyperlink is to another file, the reader must have access to that file.

While typing a document or when finished, a user can edit the font (typeface) and its color and size. A user also can enhance or emphasize text by making it bold or italic or underlining it. Users also can change the paragraph formatting, such as the alignment and spacing of a paragraph.

To make changes to the font or paragraph select the text or paragraph and click on the appropriate button on the Format toolbar or select Format → Font or Paragraph. Select the appropriate options from the dialog box that appears. The menu option enables a user to make several simultaneous changes. All text a user enters after a format change reflects the change.

More advanced features include adding notes, observations, and comments to documents. Many people use these in work environments in which a team of people works together to develop and review documents. Individuals review the documents. Instead of making changes individually, they add notes and comments. The person responsible for the document reviews and evaluates all observations and comments and makes appropriate changes. The comment function is under the Insert menu.
Most Word Processors also have a spell and grammar check feature. This helpful tool finds spelling and grammar errors. The word processor marks each spelling error with a red wavy line under the word and each grammar error with a green wavy line under the word or words. Right click on the misspelled word or grammar error; a pop-up menu appears that offers several choices. A user can change a misspelled word to the correct spelling, ignore the error, or add the word to the dictionary. Not all words one might use in a document are in the dictionary so occasionally it is necessary to add words. For a grammar error, the pop-up display shows the error and sometimes provides a correction solution or suggests a rewrite.

To print a finished document, follow these steps. With the computer connected to a printer, select File → Print or click on the Print button on the Standard toolbar. Under File → Print, the Print dialog box appears. Select the appropriate options such as the number of pages or the number of copies. If the user clicks on the Print button on the Standard toolbar, the application prints a single copy of the entire document.

Word Processing applications make the task of creating almost any type of document easier. To learn more about using a word processing application take a class, order a training CD, take an online tutorial (several are free), or just use the application and its help feature.

Spreadsheets

Another common application enables users to create spreadsheets. Using a spreadsheet, often called an electronic ledger, a user can enter text, numbers, and formulas. The primary use of spreadsheet applications is working with numbers. Users can enter data, set up calculations, obtain and interpret results, and establish or update plans. Spreadsheets are valuable tools for creating a personal budget, keeping track of grades, and computing how much money one has available for purchases. Businesses use spreadsheets to keep track of their finances and the hours their employees work. Some people use spreadsheets as address books or as tools to keep track of CDs and DVDs.

Some of the most popular spreadsheet packages available are Microsoft Excel, Quattro Pro, and Lotus 1-2-3. This lesson uses Microsoft Excel to explain spreadsheets. Other spreadsheet applications are similar to Excel but there are differences. The overall concept of entering labels (text), values (numbers), and formulas is common to all spreadsheet applications.

A spreadsheet consists of columns (identified by letters) and rows (identified by numbers). The intersection of a column and a row is a cell. One enters data in a cell. A cell reference identifies the location of the cell within a spreadsheet and consists of the column letter and row number, such as B2 (column B, row 2).

When a user opens a spreadsheet application, a blank workbook appears. Figure 3-6 shows an annotated reproduction of an Excel workbook.
Excel consists of several production elements and features. Table 3-2 explains the available elements.

**Table 3-2. Excel Production Elements**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Worksheet</strong></td>
<td>The <em>worksheet</em> is the working area. A file (workbook) can have as many as 50 worksheets. A user can assign any meaningful name to a worksheet. To change the name of a worksheet, double click on the worksheet name (Sheet1), enter the new name, and press the Enter key. The default number of worksheets is three but users can add additional worksheets. A workbook can include as many worksheets as necessary as long as the user has enough storage space. To add additional worksheets, select Insert → Worksheet. Each worksheet contains 256 columns and 65,536 rows. To access a different worksheet click on the worksheet name. The spreadsheet enables users to perform calculations using data from multiple worksheets. For example, a user could have a separate worksheet for each monthly budget and a yearly sheet that displays the annual budget.</td>
</tr>
<tr>
<td><strong>Name box</strong></td>
<td>The <em>name box</em> provides the cell reference of the active cell. A user can enter a cell reference in the name box and press the Enter key to change the viewable active cell.</td>
</tr>
<tr>
<td><strong>Insert Function (fx)</strong></td>
<td>Selecting <em>insert function</em> (fx) provides a dialog box of functions that enable a user to create formulas. A selected function displays a brief description and prompts the user to enter values.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Formula bar</td>
<td>The formula bar displays the formulas a user enters in a cell. When the user types data in a cell the information also appears in the formula bar. After the user presses the Enter key after entering a formula, the result of the calculation appears in the cell but the formula appears in the formula bar.</td>
</tr>
<tr>
<td>Scroll Bars</td>
<td>The scroll bars and scroll arrows enable a user to navigate within the worksheet. One can scroll either vertically or horizontally within a spreadsheet. If the worksheet contains more data than viewable on the screen, click on the appropriate scroll arrow or drag the appropriate scroll bar. Clicking on the horizontal scroll arrow causes the display to move one column at a time; clicking on the vertical scroll arrow causes the display to move one row at a time.</td>
</tr>
<tr>
<td>Cell</td>
<td>The cell is where a user enters data (a label, value, date, or formula). It is the intersection of a row and a column.</td>
</tr>
</tbody>
</table>

A label can be numeric or alphanumeric and helps describe or categorize data. Users can format text just as in a word processing program, selecting font type, size, and color and bold, italicize, or underline. Formulas cannot contain labels.

Values are numbers a user enters in a cell or the numeric result of any calculation. The user can enter whole numbers, decimals, negative numbers, currency, and scientific notations. The entered numeric value aligns to the right of the cell. The user can format the cell for currency using the comma, indicate percentages, and determine the number of decimal places to display. These features reside on the formatting toolbar. Click on the button to activate the feature.

Dates in a worksheet can represent the creation date or a date the application uses for calculations. A user who has a payment due every 45 days can calculate when the next payment is due based on the date of the last payment.

Formulas make spreadsheet applications powerful tools. Formulas use any designated values in the spreadsheet to perform calculations. A formula can perform functions ranging from basic arithmetic operations such as addition, subtraction, multiplication, and division to complex operations for statistical analysis or trigonometry. Normally in a formula one uses cell references so that if a value changes in one of the cells the formula recalculates and returns the new value. For example, if a formula calculates a course grade based on test scores and one of the test scores changes, the overall grade changes as Figure 3-7 illustrates.
A function may be as simple as the Average function, which returns the average from the range of provided numbers, or as complex as determining a monthly mortgage payment. One need not know the exact formula for the function, but need provide only the arguments (which are the values and can be a constant or a cell reference). The average function looks like \( =\text{AVERAGE} (D5:D8) \) and it takes the values from cells D5, D6, D7 and D8, adds them together, and divides them by 4 to determine the average.

The function to determine a monthly mortgage payment looks like \( =\text{PMT}(4.9/12,360,115000) \). PMT is the payment function, the arguments are the interest rate divided by 12 (to determine monthly interest rate), the total number of months for the loan, and the financed amount. Instead of actually entering the values the user can have each of the values in a separate cell and then use the cell reference as the following illustration shows.

Refer to a cell either by its cell reference or by its name if applicable. Refer to cells individually or as a group. If referencing adjacent cells as a group, enter the first cell in the range, a colon, and then the last cell in the range. For example, D4:D8 refers to cells D4, D5, D6, D7, and D8. A range of cells also can cover several rows and columns. Enter the upper left cell first, then a colon,
then the lower right cell, such as A1:C5 (refers to cells A1 through A5, B1 through B5, and C1 through C5).

Another excellent feature of spreadsheet applications is converting data into charts. The chart provides a graphical representation of the data in the worksheet and is sometimes easier to understand than the data itself. When a user updates a value in the spreadsheet, the chart automatically reflects the change.

![Figure 3-9. Conversion to Chart](image)

Additional features enable users to perform data analysis. Users can sort data and perform what-if and goal-seeking analysis. Users can sort data in either ascending or descending order for better viewing. What-if analysis enables a user to manipulate data for different scenarios. A user who is purchasing a new vehicle can use what-if analysis to determine how much the monthly payment would be for different interest rates or different loan amounts. Goal-seeking uses one value to determine another value. A user who is purchasing a new home and can afford a mortgage payment of $750 a month can use the goal-seeking tool to determine the maximum amount he or she can borrow without exceeding that limit.

Knowing how to use a spreadsheet application can be very beneficial in both personal and business affairs. It is important to understand the concepts and become familiar with using spreadsheets. The spreadsheet applications contain extensive help files. There are multiple on-line tutoring websites and books are available, as are classes on how to use the application. Depending on the occupation, there is a good chance anyone will come across a spreadsheet at work and they have multiple uses at home.
**A database or database management system (DBMS) enables one to organize a collection of related facts and answer questions about the collected data.** The card catalog at a library and a telephone book are examples of non-computerized databases. The old card catalog at the library enabled people to look up books by the author’s name, the title of the book, or the subject. One did have to look through several cards to find the right book. In a telephone book, one can look up a telephone number by the person’s last name, but to find out who belongs to a known telephone number requires a reverse directory; these are not readily available. With a computerized database, one can search against the telephone number field and quickly determine to whom a telephone number belongs.

Databases are everywhere today. For example, grocery stores use them to keep track of inventory. When the cashier scans an item, not only does it add the price of the item to the total, it removes the item from the inventory list, which could generate a report stating that it’s time to order more of that item. Hospitals, doctors’ offices, workplaces, schools (to keep track of the classes students take, their grades, and their completed credits), and sports teams (to keep track of the players, their personal accomplishments, and the team’s statistics) use databases. Anyone can use a database at home to keep track of CDs, DVDs, or a videotape library or as a personal address book.

Some of the popular database applications are Microsoft Access, Corel Paradox, and Lotus Approach. Some workplaces use a Microsoft SQL, Oracle, or Sybase database, depending on project size.

To understand how a database works one must learn associated terminology. A database consists of fields, records, and tables. Figure 3-10 illustrates a database table, and table 3-3 explains database terminology.
Table 3-3. Database Terminology

<table>
<thead>
<tr>
<th>Item</th>
<th>What it is</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Field</strong></td>
<td>A field is the smallest element of a database. Each individual piece of information in a database is a field. A workplace may have a database that contains information about each employee such as the employee’s last name, first name, middle initial, social security number, address, city, state, ZIP code, telephone number, position, and department. Each one of the listed pieces of data represents a field. Always break the data down to the lowest level. For example, if a name field is necessary, it is best to have a last name field and a first name field.</td>
</tr>
<tr>
<td><strong>Record</strong></td>
<td>A record is a collection of fields that represents one person or object. In the above example of the employee database, the information concerning one person is a record. Therefore, the first employee is record one, the second employee is record two, and so forth.</td>
</tr>
<tr>
<td><strong>Table</strong></td>
<td>A table is the complete collection of records. For the employee database, the table consists of all of the employee records. A table consists of two or more records.</td>
</tr>
</tbody>
</table>

After creating the structure for a database, the user can begin to enter data. After entering the data, the user can use and manipulate that data by sorting, running queries to find certain types of information, and generating reports. For example, a report is an easy way for a user to identify all of the employees in the finance department and what positions they hold.

A table has a specific number of named columns (fields) and an unspecified number of unnamed rows (records). It is not necessary to fill in all of the fields within each record, but at least one field must have data to create a record. Normally, there are fields that must have data and others for which data entry is optional. When creating the database structure, the user decides whether a field is mandatory. In the employee database, the last name and first name may be required fields but the telephone number may not be.

There are different types of database structures, but the two most common are the flat-file and relational databases.

A flat file database is one in which only one table exists. Single users normally use this type of database for small businesses or homes to keep track of mailing lists; CD, DVD, and videotape libraries; or recipes. Often this type of database resides in a spreadsheet rather than a database application. Flat file databases are fine for maintaining a home management or small business database but are very limited. These databases, especially if a user has several with redundant data, are very difficult to maintain. A much better approach is to use a relational database.

A relational database is one in which multiple tables exist and the tables are related to each other by a common field that exists in two tables. The employee database might have one table that consists of the employees, one for positions, and one for departments. The employee table can include the position field and the position table can include the department field. The user then creates a relationship between the employee and position tables and another relationship between the position
and department tables. It is then possible to run a query that produces a list of all the employees and their positions by department.

The relational database is the most popular database today. Examples of the information in a typical relational database for a business include employee information, inventory list, customer information, and order information.

A **database management system** is a program that manages the data within databases. A database management system enables a user to create the database structure and to enter, view, and manipulate the data using forms, queries, and reports. Finding the data is an important aspect of database management as it enables a user to locate a piece of data among thousands of records quickly. Database management systems enable multiple people to simultaneously access the database to enter, update, or delete records, run queries, or generate reports.

A **database application** such as Microsoft Access provides the necessary tools to create tables, add data to tables, view tables, sort data, generate reports, and create queries.

To create tables one must first create fields. For each field the user must enter a name, specify the type of data it may contain, and specify the field size. The field type and size are very important because they determine what type of data and how much data one can enter in each field. The database application lists the various field types it supports and each type has a default field size that the user can change. Commonly available field types include:

- **Text fields** (alphanumeric or character fields) enable users to enter alphanumeric or special characters into the field. Name, address, city, state, telephone number, and ZIP code are examples of text fields. Although telephone numbers and ZIP codes contain only numbers, they are text fields because they do not enter into calculations.

- **Numeric fields** enable users to enter numeric values and use those fields for calculations. Numeric fields include numbers, currency, percentages, and other values the user needs for calculations. For example, in the quantity field, the user enters how many of a particular item to order. The database multiplies that number by the cost per item to calculate the total cost.
• **Date and time** fields enable users to enter the date or time. The database displays the date and time in a format we recognize but the computer changes it to a number for use in calculations. For example, the database can determine how many people have not paid a bill in more than 60 days.

• **Logic fields** (Boolean fields) enable users to store one of two values, such as yes/no, or true/false. For example, this records whether a customer wants an order shipped overnight express (Yes) or not (No).

• **Object fields** (binary fields) enable a user to add a graphic, image, audio, or video file to a database. For example, a college database may include a photograph of each student in the student table.

• **Auto-number fields** (counter fields) tell the computer to generate a unique number for each record. The user may determine the starting and ending number for the field but every time the user adds a new record, the computer generates the next number in the series. For example, in an order table, each time a user adds a new order record the application automatically generates the Order ID. This is a good way to ensure that every record is unique. In an employee table, it is possible to have two employees with the same first and last names; auto-number guarantees the record is unique.

• **Memo fields** enable users to add lengthy comments. For example, Microsoft Access limits text fields to a maximum of 255 characters. Creating a memo field instead of a text field makes it possible to include descriptions or comments more than 255 characters long.

After creating a table, the user begins entering data. Users can enter the data directly into the table by tabbing or using the right arrow key to advance to the next field or can create a form that makes data entry easier. Data entry forms control how the user-entered data goes into the database. For example, even though a user enters a telephone number as (954) 123-4567, the database stores it as 9541234567 (no spaces or hyphens). It is also possible to have the entered data from one form go into fields in various forms. The person who is entering the data does not need to understand the structure of the tables that make up the database.

Ease of viewing the data is an important part of any database. What is the sense of entering data into a database if one cannot later retrieve that data in a form that is easy to read and understand? Users can view the data one table at a time. For a very large table with several hundred records, a user can filter the data to view what is necessary. In some database programs, users can create forms and reports that enable them to view the data in more user-friendly ways.

Sorting data is a very powerful tool that database programs provide, enabling users to sort thousands of records quickly. For example, if a database has a customer table, the software can sort them quickly by state, city, and last name. This feature enables users to find records easily.

Questioning a database enables a user to find a specific record or group of records. Like sorting, running a query makes it easier to find specific data. Instead of having to view all the records in the table, the user views only queried records and the information the application returns can come from multiple tables. For example, in the employee database, a user may want to find all employees
who work as analysts, with their first and last names, their positions, and their departments. The query tells the application to retrieve the first names, last names, positions, and departments of all employees who are analysts. The database extracts the information from three different tables.

Most database programs have a special window or form in which to create queries. In most cases, the database administrator creates generic queries and individual users enter the specific data they want.

Generating reports is another way to retrieve data from a database. Applications such as Crystal Reports enable users to build reports that retrieve the data from the database and present the data in an easy-to-read format. Reports can be standardized so that users simply run them whenever necessary. In other cases users design tailored reports for which they must provide the parameters for each report.

Databases exist in almost every business in one form or another. In most cases, individual users need only enter data into and retrieve data from the database and do not deal with the structure of the database. It is good to know how a database works. It is possible to find online tutorials, books, and classes on how to build a database. The help feature of the various applications provides additional information on how to use databases.

**Presentations**

Presentation software programs revolutionized the creation and display of presentations. Before the development of presentation software, creating a presentation was a long, drawn-out process involving many participants. First a user had to create the presentation material by writing it out and drawing the desired graphics. The material then went to a printer for typesetting. The user then created transparencies using a copier or photographed the materials to create 35mm slides. It was difficult to update a presentation because that required repeating the entire process. Often, people simply typed their material and then created transparencies.

Now users can create professional multi-media presentations that include text, color, graphics, charts, and even animation and sound quickly using presentation software. Some popular presentation software applications are Microsoft PowerPoint, Corel Presentations™, or Lotus Freelance Graphics. The typical presentation application enables users to create slides and slide notes and provides tools to enhance the slides. The software has templates for different slide layouts and backgrounds and animation themes. Additionally, presentation templates and wizards provide layouts and hints on what to enter on the slides. These slide presentation enhance a briefing or speech.

Microsoft PowerPoint, like Microsoft Word, provides various templates and wizards. Opening PowerPoint brings up the window in Figure 3-12.
Figure 3-12. PowerPoint Window
Table 3-4 explains the elements of the PowerPoint window.

Table 3-4. PowerPoint Window Description

<table>
<thead>
<tr>
<th>Item</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Bar</td>
<td>The title bar displays the application name and file name if the user has saved the file. If not, it has the name Presentation1. In the right-hand corner of the title bar are the window’s minimize, maximize/restore, and edit buttons.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>The menu bar displays the various menu options for PowerPoint; they are File, Edit, View, Insert, Format, Tools, Slide Show, Windows, and Help. Each menu option contains commands that relate to that menu. For example, the Slide Show menu option includes choices to view the slide show, set up the slide show, and add animation to the slide show.</td>
</tr>
<tr>
<td>Toolbars</td>
<td>The Standard, Formatting, and Drawing toolbars appear by default when a user opens PowerPoint. Users can open additional toolbars by selecting them from the View menu under the Toolbars option. The Drawing toolbar makes it possible to draw objects within a slide. The Standard and Formatting toolbars have many of the same options as they do in Microsoft Word and Microsoft Excel.</td>
</tr>
<tr>
<td>Slide Thumbprint and Outline Pane</td>
<td>The Slide Thumbprint and Outline pane appears on the left side of the window and provides an additional way to add text to a slide or quickly see all the slides in a presentation. First, select the tab to view, either thumbnails or outline. In the outline view, the software displays only text and a user can add and delete text from this tab. The thumbnail view provides a miniature display of all the slides in a presentation. Selecting a slide brings that slide into the main work area. The user can change the slide order in either pane by dragging the slide to a new location. Close the pane by clicking the left mouse button on the “x” in the upper-right-hand corner of the pane.</td>
</tr>
<tr>
<td>Slide View Buttons</td>
<td>To change how to preview the slides, select one of the three buttons located in the lower left hand corner of the window. They are, from left to right, the slide view, the slide sorter view, and the slide show. The slide sorter view displays the slides as thumbnails; users can change the order of the slides, hide and unhide slides, and add slide transitions and animations. The slide show view activates the slide show.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>The Status bar shows which slide is currently in view and how many slides exist in the presentation, the design template in use, the current language, and the spell checker icon. A red “X” on the spell checker icon indicates a spelling or grammar error.</td>
</tr>
<tr>
<td>Task Pane</td>
<td>The Task Pane on the right side of the window provides different panes of commands. The New Presentation pane opens an existing presentation, a blank one, or one from a template or wizard when a user selects the appropriate link. Other panes are insert clip art, slide design template, clipboard, custom animation, slide layouts, slide design color, slide design animation, and slide transitions. To switch task panes, click the left mouse button on the down arrow on the task pane and select the appropriate choice from the pop-up menu that appears.</td>
</tr>
</tbody>
</table>
To create a new presentation, first open the presentation application. This lesson discusses Microsoft PowerPoint, and while the other presentation applications work similarly, there are differences.

First, select a slide design from the several available. The slide design provides default background color and design, font color, enhancements, and size and type of bullets. With no selected design style, the background appears as a blank white screen. By selecting a design first, a user can see how the final product will look. If the user changes the design style or waits until after developing the presentation to select a design style, it may be necessary to edit the slides so the text fits with the new design.

The default for the first slide in a presentation is the title layout. To use a different layout, select the desired one. The layout determines how the software displays the data on a slide. Available choices include, among others, a blank slide, one with just a title, or one with a title and two columns, one for bullet statements and the other to hold a graphic. The slide appears in the main working area with the design of choice and frames that map out the chosen layout. A dotted line surrounds each framed area and inside the frame, it states, “Click to add, title, text or content.” Click inside the frame and start typing or select the type of content to add. When adding text to a slide, keep it simple. Slides should have bullet statements that jog the presenter’s memory. Do not write an essay on a slide.

Users can import objects into slides. PowerPoint can display three-dimensional images of objects and display them from all sides. This is especially useful in scientific and technological presentations.

After finishing each slide click on the New Slide button. The user can select any layout for each slide. The slide design should be the same for the entire presentation but the layout can change from slide to slide. Continue adding new slides until the presentation is complete.

After designing all the slides, a user can add slide transitions or animation. Using slide transitions properly can enhance the presentation, but the opposite holds true as well. A slide’s transition determines how PowerPoint displays each slide as the presentation proceeds. There are several options to choose from to add visual impact to the presentation.

Users also can add animation to slides. The animation feature enables a user to determine how to use animation to display the text. Like a slide transition, proper animation can enhance a presentation and improper or overdone animation can detract from it. A user can add animation themes to the entire presentation or to each slide individually using custom animation. The software enables a user to choose whether items appear on a slide all at once or one bullet or object at a time, whether to use sound effects as the items appear, and whether to have the animation occur automatically or on a mouse click.
Although all these features are useful, too many bells and whistles detract from the presentation. Content is more important than entertainment value. It is necessary to present the information in the best manner possible for the intended audience. A presentation to elementary school children on the hazards of playing with matches can be effective with quite a bit of animation, sounds, and transitions, but a presentation in the workplace often requires a more conservative approach.

After building the slides and adding transitions and animation, it is time to view the slide show. Click on the Slide Show icon in the lower left-hand corner of the screen or select View Show from the Slide Show menu option. The user can set up the slide show to either advance to the next slide automatically or on the click of the left mouse button. Other features under the Slide show menu option enable users to rehearse timing and add custom shows. By creating custom shows, a user can build one presentation file and then customize it to meet the needs of different audiences.
LESSON 3 STUDY QUESTIONS

ANSWER TRUE OR FALSE FOR EACH QUESTION. CHECK YOUR ANSWERS.

1. Word processing software empowers users to add information from many media, read and evaluate it, and use it to develop documents.

2. In a spreadsheet, the intersection of a column and a row is a field.

3. A database or database management system (DBMS) enables one to organize a collection of related facts and answer questions about the collected data.

4. The two most common databases are the flat-file and relational databases.

5. A table has a specific number of named columns records.

6. Text fields can only be alphabetical.

7. Questioning a database enables a user to find a specific record or group of records.

8. PowerPoint can not display three-dimensional images of objects and display them from all sides.

9. Microsoft PowerPoint, Corel Presentations™, or Lotus Freelance Graphics are examples of presentation software.

10. Questioning a database enables a user to find a specific record or group of records.

ANSWERS TO LESSON 3 STUDY QUESTIONS.

1. TRUE  6. FALSE
2. FALSE  7. TRUE
3. TRUE  8. FALSE
4. TRUE  9. TRUE
5. FALSE 10. FALSE
LESSON 4

THE INTERNET

How does a user sit at a computer at home and chat with a person living in another country or on another continent? Before the Internet, we used the telephone or telegrams to communicate quickly with others. The ability to communicate electronically (data communication) is feasible because of enhancements to the telecommunication system that was already in place. This unit addresses how to connect to the Internet and, once connected, what a user can do.

CONNECTING TO THE INTERNET

A user just bought a new computer and has everything connected. What must now happen to access the Internet? Most computers available today are ready for Internet connection, with internal modems or network interface cards and the proper software. Some computer companies also include a free 6-month subscription for an Internet Service Provider (ISP) with purchase. One must meet the following requirements to access the Internet.

First, make sure all the proper hardware and software came with the computer and find an ISP. Then it is time to begin exploring and taking advantage of all that the Internet has to offer.

The type of hardware necessary depends on how a user plans to access the Internet. Available methods include a home telephone line, a cable connection (the same as television), a satellite connection, Integrated Services Digital Network (ISDN), Digital Subscriber Line (DSL), wireless connections, and WebTV, which requires a TV and not a computer.

To connect to the Internet a user needs a computer (unless using WebTV), the equipment appropriate to the type of connection, cabling, and service appropriate to the connection method.

Dial-Up Connection

To access the Internet via a home telephone and use dial-up service, a user must have a computer, telephone line, telephone wire to connect the modem to the telephone jack on the wall, and a modem. The modem can be either internal or external. To see if the computer has an internal modem look at the back and see if there is a telephone port (an RJ-11) to plug the telephone wire into. Some computers have a diagram of a telephone above or below the jack. Plug in the telephone wire to check because the network connection looks like a telephone jack (port) connection but is a little larger. If the computer does not have an internal modem, one must purchase either an external or internal modem. Internal modems are less expensive. They cost between $15 and $30 and require installation. External modems are a little more expensive, costing between $25 and $75, but they are easier to install. They simply plug into either the Serial or USB port. A modem functions by converting digital signals that the computer transmits to analog signals that travel along the telephone lines; the receiving computer’s modem converts them back to digital signals. While connected to the Internet, one cannot make or receive telephone calls on the same telephone line. A sound similar to a fax machine...
transmitting replaces the dial tone when the computer connects to the Internet. Some people have two telephone lines, one that is dedicated for Internet use. The Internet Service Provider (ISP) can be a local, regional, or a national provider.

![Figure 4-1. Internet Access Methods](image)

**Cable Connection**

To access the Internet via cable requires a cable connection, a cable modem, a network interface card, Ethernet cable, and cable service. Many cable companies now provide Internet access over the same cable line that provides cable TV service. The advantage is that a cable connection is about 100 times faster than the telephone dial-up service. This type of connection is called broad-band and enables one to watch television and surf the Internet at the same time. To determine if the computer has an installed network interface card, look for the appropriate port, which is similar to a telephone jack connection, but larger (an RJ-45). Like the telephone jack connection, the markings may indicate that it is the LAN connection. If the computer does not have one it costs approximately $15 dollars to purchase one, and it requires installation. Additionally, cable modem service requires an Ethernet cable long enough to connect the computer to the cable modem. Connect the cable modem to the coaxial cable, which is the same as the television cable. Using cable as the Internet connection means the Internet and cable service providers are the same. This type of connection is growing more widespread as cable companies expand their services.

**Satellite Connection**

Accessing the Internet via a satellite connection requires a satellite dish, a clear line of sight to the southern skies, an indoor satellite receive and transmit unit, a USB port, and coaxial cable. The satellite dish resides outside where it has an unobstructed view of the southern skies. The dish connects to the indoor receive and transmit unit via a coaxial cable and the computer connects to the
same unit via a USB cable. Satellite connection is more expensive than other connection services and only necessary for users who require high-speed connections when cable modem, ISDN, or DSL are not available. The ISP is one of the many satellite companies that offer the service.

**ISDN Connection**

To access the Internet using ISDN connection requires a special telephone line and service, an ISDN modem, network interface card, and Ethernet cable. The telephone, fax machine and computer connection can be used simultaneously with an ISDN connection. The connection to the Internet is more than twice as fast as a dial-up connection. Telephone companies that provide Internet connection services support this type of technology. ISDN connection fees are higher than regular dial-up. ISDN technology is not widespread because of cable modem, DSL, and Satellite services.

**DSL Connection**

Accessing the Internet using a DSL connection requires a DSL modem, a telephone line, DSL service, a network interface card and Ethernet cable, or a USB port and cable. It is possible to surf the Internet and make a telephone call at the same time with a DSL connection. The computer connects to the DSL modem via the network interface card or the USB port. The modem connects to the telephone jack. DSL use is growing and starting to replace ISDN connections.

From a home computer a user rents access time from an Internet Service Provider (ISP) who provides the connection. Some of the most common ISPs are America on Line (AOL), Net Zero, People PC, and Comcast. These providers usually provide access from anywhere in the United States. In some areas there are regional ISPs, such as AT&T, Nationwide, or some that provide access to the Internet to individuals only within a local area such as a city or county. ISPs are usually up and running 24 hours a day, 7 days a week, and 365 days a year. The ISPs then connect to Network Service Providers (NSP) and the NSPs connect to Internet Servers that contain the files a user can access.

To find the best ISP it is important to shop around. First determine how many people need access to the Internet, for what purpose, and how often and how long each day. Do one or more users need Internet access away from home? Answering these questions makes shopping for an ISP easier. There are local, regional, and national Internet service providers. The following are some questions to answer to compare ISPs.

- **Cost** – What does the Internet service provider charge for activation and monthly service? Does the service charge include unlimited access? How many e-mail accounts does the fee include? Most ISPs have a monthly fee for unlimited access. Some ISPs offer plans in which they charge a reduced monthly fee but limit access time to approximately 15 hours a month.

- **Local Access Numbers** – How many local access numbers are available and for how large an area? For users who travel great distances this is an important question, especially if they require Internet access while traveling. Avoid paying long distance charges and find an ISP that provides several dependable local access numbers.
**Customer Support Service** – Does the ISP have customer support and if so, what are the hours, how can a user contact them (e-mail or telephone), and how competent are they?

**Reputable Company** - Check the local Better Business Bureau to see if any reports on the company exist. Ask friends and co-workers which ISP they use and why.

**Restricted Access** – Does the ISP restrict access to certain sites?

**Extra Services** – Most national ISPs such as AOL, CompuServe, and Prodigy include other services such as chat rooms, groups, instant messaging services, firewall services, and e-mail. Local providers may provide only one e-mail account and access to the Internet.

The ISP provides the user with all the necessary information to set up and connect to the Internet. For this last step follow the service provider’s instruction for creating the account and setting up the software. Some ISPs have their own software to connect to the Internet. Otherwise, several kinds of Internet software are available, the two most popular being Internet Explorer and Netscape.

**The Internet**

The Internet we know today evolved from a military project that started in the late 1960s and connected four different sites. From the 1970s to 1990s there was steady growth and in 1993 the Internet explosion took place. The Internet now spans the globe with over 300 million users worldwide. From Miami, a user can access a web site that resides on an Internet server in New Zealand, Chile, or, Alaska in a matter of seconds. Two major accomplishments that occurred to make this happen were the invention of the personal computer and the development of a graphical user interface application to interact with the Internet (which happened in the early 1990s). The Internet is a network of networks and all are responsible for their own networks. No one person, company, or nation owns the Internet.

The Internet offers a variety of services, such as access to the worldwide web (WWW), electronic mail (e-mail), and file transfer protocol (FTP).

After connecting to the Internet one can:

- Use e-mail to communicate in near-real-time with family, friends, and co-workers.
- Search for information on almost any topic.
- Find entertainment by playing games with others, listening to music, and watching video clips.
- Join a discussion group based on a topic of interest and meet others who have the same interest.
- Download new software programs to try out. Several sites offer shareware software, which is available for a limited number of trial days.
Chat live with others. Chat in a room with a group of users or individually with one other user. The technology has advanced and now has both audio and video capability.

Shop online to purchase almost anything, any time of the day, from the comfort of home. Purchase airline tickets, send flowers, buy clothing or groceries, or order pizza for delivery. It is safe to provide credit card information over the Internet to secure sites. A secure site uses https in the address box instead of http and displays a picture of a lock in the lower-right-hand corner of the status bar.

Attend school. Many colleges and universities offer online degree programs that allow an individual to attend class when it is convenient. Additionally, there are web sites that offer free online tutorials for numerous topics.

Stay informed. Almost all news stations and newspapers now have web sites one can access to read the latest news story or watch a video clip. Some also offer a subscription service. Subscribers receive email notification of breaking news and important stories.

Work from home operating a home-based business or telecommute. Telecommuting is working from home for an employer, which is becoming more widespread.

The World-Wide Web

The world-wide web (called the web) is a service that is available on the Internet. Most users use the two terms interchangeably, because it is one of the most-used services. The web consists of documents stored on computers (web servers) around the world. These documents, which are web pages, can include audio, graphics, images, text, and video. Web designers build web pages using a special mark-up language, the most popular of which is Hyper-Text Mark-up Language (HTML). The web designer creates a web page and stores it on a web server. A user can then access and view that web page.

To view web pages, a user needs a web browser; the two most popular ones are Microsoft Internet Explorer and Netscape. When a web browser first opens, it defaults to the homepage, often the ISP’s web page. A user can change the homepage to the web page of choice by changing the Internet options. In Microsoft Internet Explorer select Internet Options under the Tools menu. In Netscape, select Preferences under the Edit menu.

Each web page has a unique address or URL (Uniform Resource Locator). When a user enters the URL in the address bar and clicks on the Go button, the requested web page appears. A web address such as http://www.fbi.gov/priorities/priorities.htm represents the protocol, computer name, directory name, and web page name.

http is the protocol. Hypertext transfer protocol the most common one. An “s” at the end (https) means it is a secure site.
**www.fbi.gov** is the Web server name.

**priorities** is the directory name. Forward slashes separate multiple directory names.

**priorities.htm** is the web page name.

Users also can navigate around the web by selecting a hyperlink (link). A hyperlink is special text or a graphic on the page that when selected displays a new page or a new area on the current page. Text that is a hyperlink is a different color (the default is blue) from the other text and is underlined. As the mouse pointer moves over a hyperlink, the cursor changes to a pointing finger. This helps identify graphics that are hyperlinks.

Users can add bookmarks (or favorites) to the web browser for sites they visit often. Then instead of having to retype the web addresses, they can access the bookmarks and connect to the web sites quickly. In addition to bookmarks, on the standard toolbar web browsers have the **Back**, **Forward**, **Stop**, **Refresh**, and **Home** buttons. The **Back** button enables a user to return to a previous page. After going back the user can click on the **Forward** button to move forward again. Users can move backward and forward multiple pages. The **Stop** button stops a page from loading; this comes in handy when a page is taking too long to download. The **Refresh** button refreshes the current page; this is helpful if a page hangs up while downloading. The **Home** button redirects the browser to the homepage.

Web browsers can display or use several different media. A webpage can contain text, graphics, images, video, and audio. This gives users a choice as to how to view a webpage. Having all these features makes the web browser an interactive tool. Users do not have to stay on the same web page from start to finish; they can move from one page to another (called surfing) and can choose to read text or watch a video.

The world-wide-web offers multiple services. One service is providing search engines to assist users in finding information. There are different types of search engines but all perform the same basic functions. A search engine web site searches the Internet looking for keywords. Whenever the search engine finds the keywords on a webpage, it stores and indexes the location of that web page. When a user enters search criteria it runs against the search engine's database and displays links that satisfy the search criteria. Each search web site provides instructions on how to enter criteria to get the best results. Some of the most popular search engines are google.com; lycos.com, yahoo.com, and ultavista.com.

The web has become an invaluable research tool. Millions of documents exist, just a few keystrokes away, concerning virtually any subject. The search engines make it possible for anyone from elementary school students, to medical and scientific researchers, to senior citizens to find needed information and to connect with the appropriate experts.

Internet research does have its pitfalls. Researchers must take care to select valid sources. Never forget that anyone can post information to the Internet! The following is a partial list of points to evaluate when researching on the web.
Electronic mail (e-mail) is another commonly used feature of the Internet. E-mail is the fastest and least expensive way to keep in touch with family, friends, and co-workers. Several e-mail applications exist for users, such as Microsoft’s Outlook and Outlook Express, QUALCOMM’s Eudora, and various web-based e-mails (Hotmail, Yahoo, Netscape, and AOL). Sending and receiving e-mail is free beyond the monthly Internet access fee.

To send e-mail to another individual the user must have the correct e-mail address. An e-mail address consists of the individual’s username (real name or nickname) and whom they have their e-mail account with, separated by the “at” (@) symbol. A typical e-mail address looks similar to Luv2teach@hotmail.com or John.Smith@draco.com.

Users can add attachments, such as documents or photographs, to e-mail. Users should enter a subject for the message in the subject line to inform the recipient about the contents of the e-mail. One should take time to ensure the message is well written and contains no spelling or grammar errors.

If a user receives an e-mail he or she can reply to the e-mail easily by selecting the reply button. A compose e-mail window appears with the e-mail address included and often the original message appears in the body of the reply. The user need only type a message. A user can also forward an e-mail to one or more individuals by pressing the Forward button. The compose e-mail window appears with the original e-mail in the body of the message. The user adds the desired address(es) and clicks on Send.

Most users can access their e-mail from any computer connected to the Internet. This enables users to check their e-mail even if they are not at home or work. It is important to check e-mail frequently and discard unneeded messages or place important messages in folders. Full mailboxes cannot receive any incoming e-mails and the user cannot send any.

The Internet plays an important part in our everyday lives. From e-mailing family and friends to paying bills or playing games, we continue to spend more time and do more on the Internet. It is important to understand what it can do and how to use it effectively.
LESSON 4 STUDY QUESTIONS

ANSWER TRUE OR FALSE. CHECK YOUR ANSWERS.

1. To access the Internet via a home telephone and use dial-up service, a user must have a computer, telephone line, telephone wire to connect the modem to the telephone jack on the wall, and a modem.

2. To access the Internet via cable requires a cable connection, a cable modem, a network interface card, Ethernet cable, and cable service.

3. Accessing the Internet via a satellite connection requires a satellite dish, clear lines of sight to the southern skies, an indoor satellite receive and transmit unit, a USB port and coaxial cable.

4. Satellite connection is less expensive than other connection services.

5. The telephone, fax machine and computer connection can not be used simultaneously with an ISDN connection.

6. The Internet we know today evolved from a military project that started in the late 1960s and connected four different sites.

7. Web browsers can display or use several different media.

8. A webpage can contain text, graphics, images, video, and audio.

9. Users can access their e-mail from only their “home” computer.

10. Web designers build web pages using a special mark-up language, the most popular of which is Hyper-Text Mark-up Language (HTML).

ANSWERS TO LESSON 4 STUDY QUESTIONS.

2. T  5. F  8. T
LESSON 5

TASK ANALYSIS AND PROBLEM SOLVING

This unit covers the necessary steps in the process of developing the software programs that make it possible to automate tasks at home or at work.

THE SYSTEM DEVELOPMENT LIFE CYCLE

Software Development

Software developers follow a process. Although there are different models to describe the process, they follow the same basic procedures. This lesson discusses the most common model. It is the six-stage development schedule.

1. Defining the problem or requirement analysis
2. Designing the program
3. Coding the program
4. Testing and debugging
5. Formalizing the solution
6. Implementing and maintaining the program

Defining the problem – System analysts perform this stage. Usually it starts when a user needs software to perform a particular function or task or a group of functions or tasks. The system analyst develops the program specifications, which programmers use to create the program. The specifications include what the input will be, how to manipulate the data, and what the output should be. Additionally, the system analyst specifies how the user interface should look and behave. The analysis must include human limitations.

Designing the program – Programmers perform this stage. A programmer looks at the requirements and prior to actually doing the coding will design the program. The programmer creates a flow chart, but can also create a structured chart or pseudo code (a written form of the programming logic).

Coding the Program – Programmers perform this stage. They actually write the program in the appropriate language, such as C, C++, VB, Java, COBOL, and so forth. When coding they have to apply the proper syntax for the language they are using. In this context, syntax means the rules for writing the program. A program will not run if there are any syntax errors.

Testing and Debugging the program – As stated earlier the program will not run if there are syntax errors. After the programmer fixes syntax errors (also called bugs) the program will run, but it may not run correctly due to logical errors in the code. Thorough testing of a program is very important. Sometimes major developers will allow users to receive beta versions of a program so that they can assist with the testing of the program. Sometimes even if it is a small company building a custom software application for a company, they may also involve some of the users in this stage. No matter
how thorough the software testing is, some errors appear after the program’s release when users are using it daily.

**Formalizing the solution** - It is in this phase that the development of the program documentation occurs. The flowchart, pseudo code, etc. becomes part of the documentation. The best programmers also put comments within the program itself, stating what and why an action occurs. This enables others to understand the logic behind why the programmer coded the way he/she did. Additionally, the developers create user and administrator documentation.

**Implementing and maintaining the program** – The system analyst delivers the program to the client to use in this stage. If it is custom-built software, the developers usually load it on the client’s computers. The programmer and system analysts are available to ensure there are no problems and that users know how to run the new application. Usually there is some form of training for the clients. The programmers normally continue to provide maintenance support of the program for a specified amount of time.
LESSON 5 STUDY QUESTIONS

FOR QUESTIONS 1-4, ANSWER TRUE OR FALSE. CHECK YOUR ANSWERS.

1. The most common model of software development is the six-stage development schedule.
2. Designing the program is a systems analyst function stage.
3. Defining the problem is a systems analyst function.
4. The programmers normally continue to provide maintenance support of the program for a specified amount of time after the software has been delivered.

FOR QUESTIONS 5—10, PLACE THE VARIOUS STAGES OF THE SYSTEM LIFE CYCLE IN THE PROPER ORDER.

| 5._____ | a. Testing and debugging. |
| 6._____ | b. Implementing and maintaining the program. |
| 7._____ | c. Formalizing the solution. |
| 8._____ | d. Coding the program. |
| 9._____ | e. Defining the problem or requirement analysis. |
| 10._____ | f. Designing the program |

ANSWERS TO LESSON 5 STUDY QUESTIONS.

1. T
2. F
3. T
4. T
5. E
6. f
7. d
8. a
9. c
10. b
LESSON 6

COMPUTER ETHICS AND CRIMES

After completing this unit students will know the commonly accepted ethical standards governing computer use and will know how to avoid both committing computer crimes and falling victim to computer crimes.

COMPUTER ETHICS

With several million people using computers, it is important to have a set of standards that everyone abides by. Standards enable us to work and communicate effectively in this era of information. In this lesson, students will learn some of the basics for using a computer ethically.

Ethics, according to Webster’s dictionary, is a set of principles that governs the actions of an individual or a group of individuals in a profession. Every computer user should follow several guidelines provided by the Computer Ethics Institute. These guidelines include, but are not limited to, the following:

General:
- Do not use your computer to harm another individual.
- Do not access another person’s computer to gain access to his or her files.
- Do not copy or use software you did not purchase.
- Do not take another person’s work and say it is your own.
- Do not use someone else’s computer without his or her consent.
- Do not use the computer to steal.
- Do check for viruses, worms, spyware, and so forth on a regular basis.

In addition to computer ethics, users should be aware of several etiquette issues concerning the use of the computer. Most of these involve use of the Internet and the new term for them is netiquette.

Electronic Mail (e-mail):
- Do not type in all capital letters, it signifies shouting.
- Do not use offensive language.
- Do not send damaging information about a person. Someone can forward the e-mail.
- Keep e-mails short and cover one topic at a time.
- Include a subject for every e-mail.
- Add e-mail addresses to the BCC: (blind carbon copy) line, if you are sending to more than one person’s personal e-mail address. This allows friends to keep their anonymity.
• **Compress attachments** if they are extremely large before attaching to an e-mail. This prevents receivers from having to wait long periods for the attachments to download and it means less traffic on the network.

• **Do not forward jokes, chain e-mails, etc.** to others. They have probably already received it from someone else and they have to waste time opening and deleting the e-mail. Mass forwarding accounts for more traffic on the network.

• **Clean out the inbox on a regular basis, especially at work.** If the e-mail box is full anyone who sends e-mail to that box receives an e-mail stating the inbox is full, thus creating more network traffic.

• **Use spell check prior to sending e-mail, especially in a professional setting.** Most e-mail packages have a spell check feature. Read e-mail before sending to ensure correct word use.

Chat rooms, including gaming rooms, are a source of entertainment for several thousands of people. A chat room is an area on the Internet that one can visit to chat (mainly in writing) with other individuals. Chat rooms serve people who share some interest, such as a hobby, cause, geographic location, or profession. Additionally, people use a feature called Instant Messaging (IM) to communicate one-on-one with friends or family instantly. Just as with e-mail, there are certain etiquette rules should follow when using either a chat room or instant messaging.

• **Do not type in all caps.**

• **Do not use offensive language.**

• **Do not attack another person verbally.**

• **Do not pretend to be someone else.** There is nothing wrong with using an alias if you do not want others to know your real name, but do not pretend to be a 16-year-old if you are in your 20s.

• **Do learn some of the jargon associated with chat rooms and instant messaging.** Several commonly used instant messaging shorthand codes are available for you to use. It is important that you learn these so you do not always have to ask for the meaning. You may find IM shorthand code dictionaries on the Internet. The following is a short list of some of the more common codes.

  o aaf – As a friend

  o aamof – As a matter of fact

  o bag – Bursting a gut

  o b/c – Because

  o brb – Be Right Back

  o gr8 – Great
INTRODUCTION TO COMPUTERS

- gotg - Got to Go
- gg  - Good Game
- kir – Keep it real
- lol – Laughing out loud or lots of luck
- nm – Never mind or not much
- np – No problem

- Do not use IM shorthand codes when writing papers or sending professional e-mails.

With so many individuals using computers and the Internet, it is important to be mindful of how and why to use the computer. **Apply the Golden Rule.** Any action a user would find objectionable is most likely objectionable to others as well. One should use a computer for personal enjoyment and not infringe on the rights of others.
COMPUTER CRIMES

Enormous advances in computer technology have taken place over the last 20 years. Unfortunately, with those advances the ability to commit crimes using the computer, and specifically the Internet, has also increased. This type of crime can be as innocent as negligence on the user’s part or as serious as intentionally stealing large sums of money from a bank or corporation. Computer crime is not always easy to discover, so it is important to understand what some of the computer crimes are and how to prevent them.

Copyright violation refers to someone copying and using another person’s information as if it was his own. When copying something from the Internet or another source, a user must give credit to the author of that material. Occasionally a web site contains a statement that users may use and distribute the information freely as long as they include the web site address or mention the author’s name.

Software piracy refers to illegally copying software or loading it on a computer. Loading a friend’s new game CD to try it out is software piracy. Committing software piracy prevents the owners of the software from being paid royalties for their work. The same happens when users download music or movies without paying for them. It is also software piracy when users who have two computers at home buy one copy of new software and load that software onto both computers.

Hacking refers to breaking into another computer’s memory (data, software). It does not matter why anyone hacks into another computer - to gain knowledge, have fun, or to steal data; it is still a crime. A hacker is an individual who finds a security hole in a computer and accesses the data. Most hackers do not think they are committing crimes and claim that they hack to gain knowledge. Other hackers intend to disrupt computer operations or steal information.

A computer virus refers to a software program that a person created to cause havoc and disrupt others’ ability to use their computers. Some computer viruses are annoying and others can actually erase all the data on a hard drive. The virus attaches itself to an electronic mail (e-mail) message or a file such as a Word document or Excel spreadsheet, or is an embedded macro within a file.

An activated virus replicates (copies) itself and attaches itself to other programs, so when you open a new program it replicates itself again and spreads from program to program in that way. Viruses that travel via e-mail not only infect the receiving machines but also contain code that sends e-mails that appear to be from virus victims to individuals who are in their address books. That is how viruses spread so quickly. To prevent viruses spreading, users must be careful of what types of e-mails they open. If the real source or sender of an e-mail is unclear, do not open any attachments to the e-mail. Opening the attachments infect the receiving computer and possibly spreads the virus to others. It is best not to open e-mail from an unknown party. Most e-mail programs now have an option enabling users to report e-mail as junk e-mail. Reporting junk e-mail is a step in reducing junk e-mail and slowing the spread of viruses.
A worm refers to a computer program that uses a network to spread itself. The worm searches for security holes on a network then attaches itself to that computer and starts reproducing on that computer. It continues until eventually the network slows almost to a halt. Worm developers also program them to perform other malicious acts such as changing web pages or sending messages. The best prevention for this is to make sure to update the operating system with new security patches.

A Trojan horse refers to a computer program that disguises itself as something it is not, such as a game. When a user executes the program, it wreaks havoc on the computer. Like a virus or a worm, a Trojan horse can perform many functions, from changing file names to erasing the entire hard drive. To prevent an attack from a Trojan horse it is best to purchase software CDs or DVDs from reputable companies. As commercial CDs or DVDs are CD-ROMs or DVD-ROMs they are probably not going to contain a Trojan horse. When downloading a program from the Internet, make sure it is from a reputable source.

Hoaxes refer to e-mails that state a virus has infected a user’s computer and the user should take specific actions to fix the problem. Often following those instructions results in deleting essential files. Users who receive this type of e-mail should first search the Internet to find out if it is a hoax. The best places to look are Microsoft’s web site or one of the various Anti-Virus software websites. Usually the name of the virus appears in the e-mail so one need search for only that name.

Identity theft and fraud are rampant and the Internet has made them easier to accomplish. It is hard to verify the identity of anyone in e-mails and on web sites. An individual can access other people’s computers and steal information such as social security numbers, bank account information, and credit card numbers if that information is in a computer. People can learn passwords if they have the proper program running to detect movements around the Internet and to record keystrokes as one types. Anyone who has this information can masquerade as another person on the Internet. The best way to prevent this from happening is to make sure not to leave important numbers in the computer. After visiting a web site such as a bank or a travel agency and entering personal information, make sure to remove the personal information from the computer by doing the following:

1. Select Tools->Internet Options from the web browser. The Internet Options dialog box appears.

2. Click on the General tab.

3. Click on the Delete Cookies button under the Temporary Internet Files section.

4. Click on the Delete Files button. This removes any files containing personal information that may reside on the computer.

People have varying motives for creating viruses, worms, Trojan Horses, and so forth. Some do it just because they can. These individuals enjoy the challenge of seeing what they can create. Others do it because they are destructive, the same as arsonists or vandals.
It is important to be aware of the various computer crimes, to avoid both committing them and becoming a victim. Taking the proper precautions makes using a computer and the Internet very enjoyable and informative. Make sure to purchase an anti-virus software program and update it on a regular basis; consider installing a firewall program that informs users when anyone tries to access their computers. When filling out a form on the Internet never include a social security number. Buying items on the Internet is very popular now. When purchasing items on the Internet, before including credit card information make sure it is safe.

![Figure 6-1. Status Bar With Lock Symbol](image1)

To verify that there is a secure connection, look at the lower-right-hand corner of the status bar for a picture of a locked padlock. If the lock is missing or unlocked, do not submit personal or confidential information. To see the status bar click on View and click on the Status Bar option. The status bar is at the very bottom of the window. Users also can look for indicators that the web site is secure, such as the two in Figure 6-2.

![Figure 6-2. Secure Site Indicators](image2)
LESSON 6 STUDY QUESTIONS

ANSWER TRUE OR FALSE. CHECK YOUR ANSWERS.

1. To verify that there is a secure connection, look at the lower-right-hand corner of the status bar for a picture of a locked padlock.

2. An activated virus replicates (copies) itself and attaches itself to other programs. When you open a new program it replicates itself again and spreads from program to program.

3. A “worm” refers to a computer program that uses a network to spread itself.

4. Hoaxes refer to e-mails that state a virus has infected a user’s computer and the user should take specific actions to fix the problem.

5. A Trojan horse refers to a computer program that disguises itself as something it is not, such as a game.

6. Copyright violation refers to someone copying and using another person’s information as if it was his own.

7. Every computer user should follow several guidelines provided by the Computer Ethics Institute.

8. Software piracy refers to illegally copying software or loading it on a computer.

9. Hacking refers to breaking into another computer’s memory (data, software).

10. To prevent viruses spreading, users must be careful of what types of e-mails they open.

ANSWERS TO LESSON 6 STUDY QUESTIONS.

1. T
2. T
3. T
4. T
5. T
6. T
7. T
8. T
9. T
10. T
LESSON 7

COMPUTERS IN THE WORKPLACE

This Lesson explains the potential negative impact of prolonged computer use at work and home and the steps students can take to protect their health. Students will learn about the effect computers have on the environment. There is an excellent chance that regardless of occupation most people will use computers in the workplace to some extent. This Lesson also discusses information technology professionals – those who support, maintain, or develop computers systems or software. Students will learn about these professions, which can be very rewarding.

Computers in the Workplace

Today workers use computers in most jobs; many use them all day at work and then after work for chatting and e-mailing friends, online shopping, taking classes, or searching the Internet. Although computers have had a tremendous impact on our daily lives and have made several daily tasks easier, they have not come without problems. As is the case with any tool, one must know how to use a computer properly. Computers have contributed to major health and environmental issues. Hardware and software designers research a vast body of scientific and medical knowledge to address these issues in their efforts to reduce the long-term effect of computer use.

Health Issues

It is difficult enough to have a job in an office and sit behind a desk all day, but it is even harder to type on a computer all day and return home to use the computer in the evening or on the weekend. This has caused some people to undergo surgery for carpal tunnel syndrome or to develop eyestrain or back and neck problems.

Ergonomics, according to Free On-Line Computing Dictionary, is “the study of the design and arrangement of equipment so that people will interact with the equipment in a healthy, comfortable, and efficient manner. As related to computer equipment, ergonomics is concerned with such factors as the physical design of the keyboard, screens, and related hardware, and the manner in which people interact with these hardware devices.”

One often hears or sees the term ergonomically correct, meaning designed in such a way as to work properly with the human body, referring to a piece of hardware such as a keyboard or mouse. Examples of ergonomically correct pieces of equipment include a keyboard whose keys angle or a mouse pad with a gel pad. Equipment that concerns computer users includes the mouse, keyboard, monitor, and chair.

Carpal tunnel syndrome is a very common repetitive stress injury that can result from entering data into a computer frequently and for long periods of time. Damage occurs to tendons in the hands or wrists, producing pain, tingling, and numbness. Often people with carpal tunnel syndrome miss days or weeks of work and in extreme cases have to have surgery.
Eyestrain is a problem people complain of frequently after staring at computer monitors for long periods. 

Computer-generated electromagnetic fields (EMFs) are another cause for concern. Although all electrical equipment and power lines generate EMFs, there is concern about possible linkage between computer EMFs and cancer. The magnetic field causes some concern but loses its strength with distance.

Anyone who uses a computer regularly should take the following actions to avoid some major health issues.

➢ **Buy proper furniture.**
  - Use a chair that has adjustable seat height and armrests and provides lower back support.
  - Use a desk designed for using a computer. It may have a tray that holds the keyboard and mouse so that the hands are at the same level as or slightly lower than the elbows. This causes the least amount of discomfort.

➢ **Use proper equipment.**
  - Those who do a lot of typing should use keyboards that have angled keys instead of flat keyboards.
  - Use a pad that provides wrist support. These pads connect to the keyboard or sit on a mouse pad. Do not rest the wrists on the pad while typing or moving the mouse, but rest them between tasks. Do not leave the hands in the same position all day without wrist support.
  - Use an ergonomically correct mouse that provides better support for the hand. An ergonomically correct mouse has a contoured shape and fits the hand better and the buttons are set in such a way that clicking on them often does not cause undo strain.
  - Place the monitor so it is between 2 and 2 ½ feet from the eyes. Position the monitor so no light reflects off the screen and if this is not possible purchase an anti-glare screen to cover the monitor. Look for monitors that do not flicker and appear to hold a steady image. It is also important to keep the monitor clean.
  - To reduce exposure to EMFs one should use a flat-panel display, as they do not emit EMFs.

Additionally, you should avoid staring at the monitor for long periods, blink often to avoid eye dryness, and take frequent breaks to stand up and stretch. Following these guidelines reduces the physical strain of computer work.
ENVIRONMENTAL ISSUES

Another concern about computers is the sheer number that exist now and the fact that most computers become outdated within 3-4 years. Thus, people are constantly upgrading their computers, computer parts (hard drives, memory and expansion cards), peripheral equipment, and software. When they upgrade people generally discard the old tools. Everyone must discard computer equipment and other associated materials such as manuals, disks, and cables properly and consider the effect on the environment.

**Take old computers to a computer-recycling center or contact the manufacturers and see if they have disposal programs.** Do not place them in the trash as they contain nickel cadmium batteries, which can be very toxic and do not belong in landfills. Consider donating an old computer to someone who could not otherwise afford one or to a charity organization where the latest upgrades are not necessary. Recycling centers refurbish what they can and properly dispose of unused parts.

The amount of energy a computer uses is another major concern. Today, computers come with many features that limit energy use. Most have a power management system one can use to direct the computer to go into sleep mode if it is idle for a specified length of time, such as 10 minutes. The hard disk stops running and the monitor might shut off as well. Move the mouse or press a key to reactivate or “wake up” the computer.

Many computers have the Energy Star logo, which means that the computer meets the U.S. Environmental Protection Agency’s Energy Star standards. The manufacturer must meet the standards for power consumption or reducing power consumption to place the logo on the equipment.

It is important to be aware of the hazards that a computer can cause and know the implications and what to do to minimize those hazards. It is simply a matter of buying the proper furniture and computer equipment and taking care of oneself while using the computer.
COMPUTER PROFESSIONS

More than likely, everyone will at some point work on a computer, whether working the cash register at a local store or actually working in one of the many computer industry jobs. Often, one of the qualifications one needs for jobs is knowledge and experience using a computer and software applications.

Those who enjoy working with computers may want to pursue careers in the computer field. There are many different computer professions, from help desk specialists to information technology (IT) managers (also called information systems (IS) managers). Job titles and computer professions vary greatly and several professions have overlapping duties. This lesson discusses several of the computer professions.

An **IT Manager** oversees the IT department and is responsible for the overall management of IT personnel and all information systems within a company or organization. The IT Manager often works with other high-level company executives to determine the technological requirements for the company and keeps the executives abreast of advancements. The IT Manager also manages the IT budget to make sure the company has the proper equipment and software to complete its business effectively. An IT Manager must have broad knowledge of information technology and business to be effective in this position and normally has a degree in Information Systems or Information Technology and often a Masters in Business Management or Administration.

**Computer Scientists** study computer theories and are often involved with new and emerging technologies. They may develop new programming languages, operating systems, or hardware. A Computer Scientist usually has at least a Bachelor’s degree in Computer Science but normally a Master’s or Doctorate in Computer Science.

**System Analysts** ensure that company information systems are current and using the latest technology. They also work with users and managers to determine if the systems in place are effective tools for mission accomplishment. After working with users and managers to determine the users’ workflow, they recommend updating applications or creating new ones. They convert user requirements into system requirements and coordinate efforts between users and programmers. System Analysts work closely with both users and others within the IT department to ensure everything works smoothly. As a system analyst, one might perform multiple tasks. Most jobs in this field require a Bachelor’s degree in Computer Science or Information Technology.

**Programmers** develop and maintain software applications. They may develop applications for commercial use or programs that are unique to a particular business. There are several different programming languages. Most programmers know two or three different programming languages. Most jobs in this field require a Bachelor’s degree in Computer Science or Information Technology and experience in specific programming languages.
Technical Writers develop user manuals, online help, tutorials, and other documentation associated with new applications or information systems. Often when developing online help or tutorials Technical Writers create storyboards and online authors develop the online help or tutorials. Most technical writing jobs require a Bachelor’s degree in English and computer knowledge, often including specific desktop publishing or word processing applications and online authoring programs.

Technical Trainers provide system training to the users. They train new hires on existing applications and provide training on new applications or upgrades to existing applications. They are responsible for ensuring that users are ready to use new systems or applications. Often the technical trainers are from the companies that create software. Many purchase contracts call for them to provide training at companies that purchase their software before and after the installation of new equipment or software. Most employers prefer that Technical Trainers have a Bachelor’s degree in Computer Science or Information Technology, but accomplished users who are able to communicate knowledge to others effectively can become Technical Trainers.

Security Administrators ensure that systems are secure from viruses, hackers, unauthorized access, and theft. They are responsible for company firewalls, password protection, network access, and other required security features. Security Administrators are responsible for the safety of encryption keys, equipment, company data files, and software. Most employers prefer Security Administrators to have a Bachelor’s degree in Computer Science or Information Technology with coursework or experience in system security.

System or Network Administrators ensure the network is up and running properly. They monitor the links between devices such as PCs, servers, hub, routers, and switches to minimize network downtime. They perform system backups on a regular basis, scan for viruses, manage servers, create and maintain user accounts, and upgrade or install new software as necessary. Sometimes they are also responsible for company telephone systems. Most employers prefer System Administrators to have a Bachelor’s degree in Computer Science or Information Technology or, at a minimum, certification in the system and network operating systems.

Database Administrators oversee company databases. They create and maintain data tables, queries, forms, and reports. They are also responsible for the integrity of the data and perform regular database backups. Most employers prefer Database Administrators to have a Bachelor’s degree in Computer Science or Information Technology and experience working with specific database programs such as Oracle, SQL, or Microsoft Access.

Hardware Technicians maintain company technology equipment. This includes computers, printers, fax machines, copiers, and projectors. They upgrade equipment, correct equipment problems, or contact the appropriate vendors. Usually they install new computer systems, move existing equipment, and lay cable for new connections. Most employers prefer Hardware Technicians to have at least an Associate’s degree in Computer Science or related field or to obtain certification as a hardware technician by taking the A+ certification exam.
**Web Developers** or **Web Masters** design, develop, and maintain company web sites. The size of specific web sites determines what they actually do. They ensure others can access their web sites and that all links within the web sites work. They monitor how many people access web sites, and ensure that no one hacks into their web servers and corrupts their sites. They use a variety of markup languages, do some programming as necessary, and are responsible for adding graphics. Most employers prefer that Web Developers have a Bachelor’s degree in Computer Science or related field and experience creating web pages.

**Help Desk Specialists** assist users with computer hardware or software problems. They respond to users’ calls and answer the users’ questions. For problems beyond their scope, they notify the second tier, who are more experienced Help Desk Specialists. Major computer companies such as Dell, Gateway, Hewlett Packard, and IBM have numbers buyers can call during the first few months of owning a new computer. For a nominal fee buyers can extend the help desk support. Most employers prefer that Help Desk Specialists have an Associate’s degree in Computer Science or related field or an A+ or Microsoft Office User Specialist (MOUS) certificate. Often third-party companies who provide the help desk services hire knowledgeable and proficient computer specialists as Help Desk Specialists.

Computers are a part of our everyday lives and it is important to become familiar with how to use them and have an understanding of how they operate. Students who enjoy working with computers may want to pursue one of the many computer jobs that exist. These are some of the more common names for the positions and many people perform more than one job depending on company size.
LESSON 7 STUDY QUESTIONS

ANSWER TRUE OR FALSE. CHECK YOUR ANSWERS.

1. Copyright tunnel syndrome is a very common repetitive stress injury that can result from entering data into a computer frequently and for long periods of time.

2. Computer-generated electromagnetic fields (EMFs) are another cause for concern.

3. “Ergonomics” is the study of the design and arrangement of equipment so that people will interact with the equipment in a healthy, comfortable, and efficient manner.

4. An IT Manager oversees the IT department and is responsible for the overall management of IT personnel and all information systems.

5. Computer Scientists study computer theories and are often involved with new and emerging technologies.

6. System Analysts ensure that organization information systems are current and using the latest technology.

7. System analysts develop and maintain software applications.

8. Technical Trainers provide system training to the users.

9. Security acknowledgements ensure that systems are secure from viruses, hackers, unauthorized access and theft.

10. Help desk assistants assist users with computer hardware and/or software problems.

ANSWERS TO LESSON 7 STUDY QUESTIONS.

1. F  6. T
2. T  7. F
3. T  8. T
4. T  9. F
5. T  10. T
COURSE OBJECTIVES

The purpose of this course is to enable students to develop knowledge of the functions, capabilities, applications, and social implications of computer technology. The student will:

- Demonstrate knowledge of the use of computer systems for processing data and accessing resources.
- Demonstrate knowledge of the functions of computer hardware and software and peripheral devices.
- Operate a computer for varied educational purposes.
- Write text, notes, outlines, comments and observations that demonstrate comprehension and synthesis of content, processes, and experiences from a variety of media.
- Interpret data that has been collected, organized and displayed in charts tables, and plots.
- Use two-dimensional and three-dimensional media techniques, tools, and process to communicate an idea or concept based on research, environment, personal experience, observation or imagination.
- Demonstrate knowledge of telecommunication concepts.
- Analyze varied tasks and problems to determine when technology is useful and select the appropriate tool(s) and technology resource(s) to address those tasks and problems.
- Select and use appropriate study and research skills and tools according to the type of information being gathered or organized, including almanacs, government publications, microfiche, news sources, and information services.
- Organize information using appropriate systems.
- Select and use a variety of electronic media, such as the Internet, information services, and desktop-publishing software programs, to create, revise, retrieve and verify information.
- Recognize production elements that contribute to the effectiveness of a specific medium.
- Know that scientific knowledge is used by those who engage in design and technology to solve practical problems, taking human values and limitation into account.
- Demonstrate knowledge of the impact of technology on careers and society and the need for its ethical use.
- Understand the impact of technology on personal, family, and community health.
- Understand that laws control the delivery and use of media to protect the right of authors and the rights of media owners.
- Know that technological problems often create a demand for new scientific knowledge and that new technologies make it possible for scientists to extend their research in a way that advances science.
- Know that the value of technology may differ for different people and at different times.
- Demonstrate knowledge of personal and occupation uses of computers and other technology.
- Critically analyze specific elements of mass media with regard to the extent to which they enhance or manipulate information.